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Section1 — Before Using

Section

Before Using
Before Using

System Requirements
% 0S8

e Windows 7 64-bit (Service Pack 1 or later)

¢ Windows 8/Windows 8.1/Windows 10 64-bit

* Windows Server 2008/Windows Server 2012

< CPU

¢ Intel Core 2, Intel Core iX CPU, or higher

¢ Intel or AMD single core CPU with a 3 GHz processor speed or
faster (multiple CPUs or multicore CPUs are recommended)

® SSSE3 (supplementary SSE3) compatibility

% Memory

* 16 GB RAM

« Hard Disk

* 6 GB or more hard disk space required for installation

«»» Network

¢ Internet connection required for activation
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Before Using

Package Contents

Please verify that the following items are included in XRE Transcoder.
¢ XRE Transcoder Installation DVD

* Serial number

¢ XRE Transcoder User Guide (Download) (this document)

Note e Activation cannot be performed without the serial
number. Please keep the serial number at a safe location,
and do not lose it. The serial number cannot be reissued
for any reason.

About This Manual

This manual serves as User Guide of “XRE Transcoder”, an option for
the XRE.

In this manual, descriptions are given based on the premise that the
XRE version 9.3 has been set up and configured.
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Grass Valley Product Support

For technical assistance, to check on the status of a question, or to
report a new issue, contact Grass Valley Product Support via e-mail,
the Web, or by phone or fax.

Web Technical Support

To access support information on the Web, visit the product support
Web page on the Grass Valley Web site. You can download software
or find solutions to problems by searching our Frequently Asked
Questions (FAQ) database.

World Wide Web:
www.grassvalley.com/support/contact

Local Support Centers:
www.grassvalley.com/ad/contact customer support

Phone Support

Use the following information to contact product support by phone
during business hours. After hours phone support is available for
warranty and contract customers.

United States/Americas +1 801 222 5204

Europe, United Kingdom,  |+44 (0)20 8867 6305
Africa and The Middle East
Asia (except Japan and +86 21 5869 8668
Korea)
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http://www.grassvalley.com/support/contact
http://www.grassvalley.com/ad/contact_customer_support

Grass Valley Product Support

Authorized Support Representative

To locate the support representative for your country, visit the Product
Support Web page on the Grass Valley Web site:
www.grassvalley.com/support.

@ grassvalley

A BELDEN BRAND

END-OF-LIFE PRODUCT RECYCLING NOTICE

Grass Valley’s innovation and excellence in product design also extends to the programs we’ve established to
manage the recycling of our products. Grass Valley has developed a comprehensive end-of-life product take back pro-

gram for recycle or disposal of end-of-life products. Our program meets the requirements of the European Union’s
WEEE Directive, the United States Environmental Protection Agency, and U.S. state and local agencies.

Grass Valley’s end-of-life product take back program assures proper disposal by use of Best Available Technology.
This program accepts any Grass Valley branded equipment. Upon request, a Certificate of Recycling or a Certificate
of Destruction, depending on the ultimate disposition of the product, can be sent to the requester.

Grass Valley will be responsible for all costs associated with recycling and disposal, including freight. However,
you are responsible for the removal of the equipment from your facility and packing the equipment to make it
ready for pickup.

For further information on the Grass Valley product take back system please contact Grass Valley at

+ 800 80 80 20 20 or +33 1 48 25 20 20 from most other countries. In the U.S. and Americas please
call 800-547-8949 or 530-478-4148, and ask to be connected to the EH&S Department. Additional information
concerning the program can be found at: www.grassvalley.com/about/environmental-policy
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— Qwverview

Section

Overview

XRE Transcoder Overview

10

XRE Transcoder adds the following functions to the EDIUS XRE
system.

¢ Converting file formats (transcoding)

¢ Creating a watch folder, to automate transcoding

The XRE Service manages the jobs to distribute the jobs to the Engines,
in the same way as on EDIUS XRE. See the EDIUS XRE User Guide for
more details.

The progress status of the transcoding jobs can be checked in the

job list of the XRE Transcoder application. The job list shows jobs
requested by the XRE Transcoder, and also jobs sent from EDIUS
clients. The XRE Transcoder application can be installed on the same
system as the XRE Service. When installed to the same system, the
XRE Transcoder application will run on management mode.

XRE Transcoder — User Guide



Setup

Installing XRE Transcoder

Section

Installing XRE Transcoder

XRE Transcoder —

Install XRE Transcoder to a PC that is within the EDIUS XRE system
network.

It can be installed on either of the PC for XRE Service, Engine, or Client.

Note * You need to set up XRE Service and Engine of EDIUS
XRE in advance.
¢ Close all other application software including resident
software before installation.
¢ Before installing the software on your PC, be sure to
login with a user ID (such as Administrator) authorized
to change system settings.

1 Set your XRE Transcoder Installation DVD into the DVD drive.
Double-click “XreTranscoder_Setup-9.xx.xxxx.exe”.

2 Click [Install].

1
XRETranscoder C

Welcome to XRETranscoder

GRASS VALLEY SOFTWARE LICENSE AGREEMENT ~
TERMS AND CONDITIONS
March 16, 2018

IMPORTANT - READ CAREFULLY: By (a) clicking the "l
agree” or "l accept” button located below, (b) downloading,
installing, copying, or otherwise using the Software, (c)
breaking or opening any seal on the packaging of the
Software, or (d) signing any signature page or cover page
accompanying these terms and conditions, LICENSEE
AGREES TO BE BOUND BY THE TERMS AND
CONDITIONS OF THIS AGREEMENT. If Licensee does not

so agree, Licensee is not granted any rights with respect to
the Software, and Licensee must not download, install, v
Version

& install Close

The installation of XRE Transcoder begins.

User Guide 11



Section3 — Setup

3 Click [Close].

#
XRETranscoder

Installation Successfully Completed

D

Close

Activation of Serial (Online)

Activation is performed after the complete of installation. Activation
requires internet connectivity environment. The function installed
when activation was not performed cannot be used.

1 Fromthestartmenu, click [Grass Valley]>[GV LicenseManager].

2 Click [Online Activation] in the [License List] dialog box

3 Enter a serial number, and click [OK].

Please enter a serial number.

Activation is complete.

POINT  ° Activation in the offline environment is also possible.
Activation of Serial (Offline) »P13
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Activation of Serial (Offline)

Activation of Serial (Offline)

If the install destination PC is not connected to the Internet, complete
activation by using another PC with Internet connection to perform
offlline authentication for activation.

1 Connect a USB stick to the PC on which XRE Transcoder has
been installed.
2 Fromthestartmenu, click [Grass Valley]>[GV LicenseManager].

3 Click [Offline Activation Create ID File] in the [License List]
dialog box.

Version Expiration

Please enter a serial number.

5 Choose the USB stick as save location and then click [Choose
folder].

6 Click [OK].

m a PC that is online
ctivating the license.

7 Eject the USB stick from the machine and then insert into a
Windows PC connected to an internet.

XRE Transcoder — User Guide 13
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14

8 Open the USB stick and then double-click [GVActivation].

Organize » Share with + Burmn =

MName

GVActivation
|| GVLicenselnfo.key
|| ID.key

9 Click [Yes].
10 Click [OK].

GV Software Activation =]

A ) License was activated
P Please register the license information to the PC where the software is
d.

installe

11 Eject the USB stick from the Windows PC and then insert to
the PC on which XRE Transcoder has been installed.

12 Click [Offline Activation Register Activation File] in the
[License List] dialog box.

License List

6 |9 =

ST d ENI O fline Activation Expiration
Register Activation File

13 Choose Response.key in the folder where the ID file of the
USB stick has been exported, and then click [Open)].

14 Click [OK].

15 Activated license will be listed. Close the window by clicking
[X]-
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Setting Example

Section

XRE Transcoder Settings

Before starting configuration of XRE Transcoder, the following

environment must be prepared.

* The XRE Service and Engine is configured and connection is
established.

* The XRE Transcoder is installed to either the same system as the XRE

Service, or on a PC that is connected to the XRE Service via network.
See the EDIUS XRE User Guide for more details.

Setting Example

In this section, each step is described based on the following system
setting example.

 XRE Service/Engine PC

> XRE Service settings
(Use a computer name: XREServer, IP address: 172.25.90.161)

XRE Service Project Folder (any folder name)

Project folder on the Server
Ex. \\XREServer\XRE_Service_Project_Folder
Port 1224 (default)
D_ays to keep jobs in 30 (default
history

> Engine settings

Node name Enginel (any name)
Server setting
Name

XREServer (any name)

Address
“XREServer” (computer name of the PC where XRE
Service is installed) or “172.25.90.161”

Port
1224 (default)

XRE Transcoder — User Guide 15



Section4 — XRE Transcoder Settings

16

% XRE Transcoder PC (Same as XRE Service/Engine PC)

> XRE Transcoder settings

Server setting
Name

XREServer (any name)

Address
“XREServer” (computer name of the PC where XRE
Service is installed) or “172.25.90.161”

Port
1224 (default)

Configuring XRE Transcoder

Perform the following settings on the PC for XRE Transcoder.

* Setting for connection to the XRE Service

* Setting for notifications of error that occurs in conversion process
* Settings for the Watch folder

1 Double-click the XRE Transcoder icon on the desktop.

2

XRETranscoder:

Alternative

¢ From the start menu, click [Grass Valley] > [XRETranscoder].

2 Click [Settings].

N Jobname Mode Status  Priority

Alternative
¢ Click [Settings] > [Setting] from the menu bar.

3 Click the [Settings] tree, and then click [Server setting].
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Configuring XRE Transcoder

4 Click [Add].

The [Server setting] dialog box appears.
% [Server setting] Dialog Box

Name ¥REServer

Address 172,25.90.161

Port 1224

[Name]  Type the name of the XRE Service.

[Address] Enter the computer name or IP address of the PC you
want to use as an XRE Service.

[Port] Enter a port number. The default setting value is 1224.

Note * You must specify a port number that is not blocked by
the firewall. The firewall is turned off with the standard
settings of a base PC.

* For a system whose firewall is turned on for operations,
the firewall setting must be changed to unblock the
desired port number.

* The system may not work properly if you specify a port
number used by other programs. Therefore, you must
specify an unused port number.

User Guide

17



Section4 — XRE Transcoder Settings

5 Set each item, and then click [OK].

6 Click [Apply].

Address
172.25.90.161

Watch Folder

POINT ° If you want to change any setting, select the XRE Service
to be changed from [Server setting] list and click [Edit].
¢ If you want to delete any setting, select the XRE Service
to be deleted from [Server setting] list and click [Delete].

Continue to configure [Error notification)].

7 Click the [Settings] tree, and then click [Error notification].

18 XRE Transcoder — User Guide
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Configuring XRE Transcoder

«»» [Error notification]

Error notification
Server setting
Error notification

Watch Folder

+ \When making an error, Beep is sounded.

[Error From the list, choose the type of errors you will
notification be notified of.
setting] If you choose [Notify errors of all jobs], you will

be notified of errors related to all transcoding jobs
instructed by the PC to each Engine.

If you choose [Notify errors of my jobs], you will
be notified of errors related to transcoding jobs
requested by this Client itself.

If you choose [No error notification], no error
notification will occur.

About error notifications» P112

[When making Check this option to make a beep sound when
an error, Beepis  delivering error notifications.
sounded.]

8 Set each item, and then click [Apply].

9 To use the Watch folder function, click the [Settings] tree, and
then click [Watch Folder].
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20

+» [Watch Folder]

Watch Folder

# Source file name _Date Time

ith the same name in the destination

[Output file name
rules]

Set the name of the files output after
conversion process.

[Source file name]
The file name will be “file name before
conversion (+ extension)”.

[Date Time]
The file name will be “date and time at
creation of output file (+ extension)”.

[Source file name _ Date Time]

The file name will be “file name before
conversion_date and time at creation of
output file (+ extension)”.

[If there is a file with
the same name in the
destination]

Set the action if there is a file with the same
name (including the extension) in the output
destination after conversion.

[Overwrite]
The file will be overwritten.

[Output file name _ Increment Number]

The output file will be named as “output
file name_000 (3-digit increment number) (+
extension)” and saved.

XRE Transcoder — User Guide
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Configuring XRE Transcoder

[Existing files in the
watch folder when
(re)connecting to
server]

Set how to process the files remaining in the
Watch folder at the time of reconnecting to
the XRE Service.

[Convert files that were not converted previously]
Converts only files that have not been
converted. Existing files to which errors
occurred will no be converted.

[Convert files that were not converted previously

and also files that failed to convert before]
Converts files that have not converted and
existing files to which errors occurred.

[Don’t convert existing files]
Does not perform any process on existing files.

[Post conversion
setting:]

Select an action after conversion of a file from
the list.

[Move source file]
Move the source file to the “Converted
Source” folder created in the Watched folder.

[Delete source file]
Delete the source file from the Watched folder.

[None]

No action will be performed.

10 Set each item, and then click [OK].

User Guide
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Plug-in settings

Configure the plug-in settings (settings according to file types) as
necessary.

If the file output destination after conversion is an FTP server or K2
Media server, set the output destination in advance in the plug-in
settings.

1 Click the [Plug-in Settings].

Eile Action Setting

[

M Jobname Sent By Node Status  Priority

The [Settings] dialog box appears.
% [Settings] Dialog Box

Note e If the terminals for XRE Transcoder, XRE Service, and
Engine are separate PCs, it is necessary that the plug-
in environment of all PCs are identical. If their plug-in
environments are different, an error may occur or your
data may not be exported properly.

2 Click the [Settings] tree, and then click an item to set.
For details on each item, see the following descriptions.

[HEVC]» P23
[QuickTime]» P24
[GXF]» P24
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Plug-in settings

[RED]» P26
[MPEG]» P26
[MXFI»P27
[XDCAM]» P28
[Dolby Digital]» P29
[K2 (SAN)I» P30
[Cinema RAW]» P32

[Sony Raw]» P32

*The plug-in settings configuration is not supported for [AVCHD] and
[Still image].

3 Set each item, and then click [OK].
You can continue to configure other settings by clicking [Apply].

[HEVC]

By utilizing hardware supporting the Quick Sync Video, you can
decode the data with the video compression standards HEVC (H.265)
with high-speed.

[Use Hardware | Check this item to use hardware decoding such as
decoder] Quick Sync Video.

XRE Transcoder — User Guide 23
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[QuickTime]

Use QuickTime for Windows to configure settings to use 3GP, 3G2,
M4V, and other MOV files.

This is displayed only when QuickTime for Windows has been
installed.

[Enable Sources in the format described in “Formats

QuickTime Added at Installation of QuickTime” can be used.

Importer] Formats Added at Installation of QuickTime» P117
[GXF]

Set the connections of FTP servers when outputting in the GXF format.

24 XRE Transcoder — User Guide



Plug-in settings

[Server]

Display a list of addresses of FTP servers set as
export destinations.

[Add]

Click this item to display the [FTP settings] dialog
box for adding connection servers.
[FTP settings] Dialog Box» P25

[Delete]

Delete servers from [Server].

[Modify]

Change the server settings.

[Move Upl/
[Move Down]

Sort the servers.

Select a server from [Server] and move the
selected server one place up or down with each
click of [Move Up] or [Move Down].

[Settings]

Display the settings of the connection selected in
[Server].

 [FTP settings] Dialog Box

[Name]

Enter the name set for the server.

[Address]

Enter the IP address or server name of the FTP
server.

[Port Number]

Enter the port number. The default port number is 21.

[Directory]

Enter the directory name of the export
destination.

[Username]/
[Password]

Enter the user name and password required when
making the connection.

[Connection
Test]

Click this item to test the connection to the FTP
server using the currently entered user name and
password.

XRE Transcoder — User Guide
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26

[RED]
< [GPU]

By utilizing GPU, you can decode RED source data in high-speed.

» XDCAM

[GPU Mode]

Selects the GPU process method.

GPU list Shows available GPU when [OpenCL] or [CUDA]
is selected for [GPU Mode]. Check GPU to be
used.

[MPEG]

Set faster seeking of MPEG files.

QuickTime

MPEG
» MxF
M

[Use Accel. Seek]

Not supported.

[A/V Check this item to use the PTS (time stamp
Synchronization | information) for synchronization of audio and
Using PTS] video.

[Get Timecode | Some MPEG files may have timecode information
from GOP in their header. Check this item to use timecode
Header] information.
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Plug-in settings

[MXF]
% [FTP Server]

Set the connections of FTP servers when outputting in the MXF

format.
The [FTP Server] setting items for MXF are the same as for GXF.

[GXF1» P24
+ [Decoder]

You can set the layer and downsample coefficient to be decoded when
importing MXF files in the JPEG2000 format.

Middle

[Quality] Specify a layer to decode.

[High]
Decode all layers.

[Middle]
Decode half of the layers.

[Low]
Decode single layer.
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28

[XDCAM]
s [FTP Server]

Set the connections of FTP servers when outputting in the XDCAM
format.

[Server] Display a list of addresses of FTP servers set as
export destinations.

[Add] Click this item to display the [FTP settings] dialog
box for adding connection servers.
[FTP settings] Dialog Box» P29

[Remove] Delete servers from [Server].

[Modify] Change the server settings.

[Move Upl/ Sort the list.

[Move Down]

Select a server from [Server] and move the
selected server one place up or down with each
click of [Move Up] or [Move Downl].

[Settings]

Display the settings of the connection selected in
[Server].
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> [FTP settings] Dialog Box

[Name]

Enter the name set for the server.

[Address]

Enter the IP address or server name of the FTP
server.

[Username]/
[Password]

Enter the user name and password required when
making the connection.

[Directory]

Select a directory type from the list.

[Connection
Test]

Click this item to test the connection to the FTP
server using the currently entered user name and
password.

POINT  ° If connection fails by the connection test, try restarting
the XDCAM device and PC after completing the FTP
server connection setup.

¢ [Importer]
Not supported.

[Dolby Digital]

Make the settings for exporting Dolby Digital.

Dolby Digital

Dyn,

Dolby Digital

5til Image

QuickTime
MPEG
» MXF
1

[Dynamic Range
Control]

Set the operation mode of the dynamic range
when Dolby Digital Professional and Dolby
Digital Plus are imported.

XRE Transcoder — User Guide
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[K2 (SAN)]

< [Server]

Configure connection to K2 Media server.

[Configure Check this item to automatically detect the server
automatically] that can be used (K2 Media server).

If the server is not detected, uncheck this item and
set manually.

[Server List] Display a list of servers (K2 Media server) set as
export destinations.
[Add] Click this item to display the [Server settings]

dialog box for adding connection servers.
[Server settings] Dialog Box» P31

[Delete] Delete servers from [Server].

[Modify] Change the server settings.

[Move Up]/ Sort the servers.

[Move Down] Select a server from [Server] and move the

selected server one place up or down with each
click of [Move Up] or [Move Downl].

[Settings] Display the settings of the connection selected in
[Server].
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Plug-in settings

% [Server settings] Dialog Box

Mapped Path

[Name] Enter the name set for the server.

[Host Name] Enter the IP address or server name of the server.

[Host Name For redundant configuration, enter the IP address

(Backup)] or server name of the server that is paired with
[Address].

[Username]/ Enter the user name and password required when

[Password] making the connection.

[Domain] Enter the domain of the server.

[Mapped Path]

Select the drive you assigned on the Client PC
side to the V: drive of the server.

[Show only
SNFS drivers]

Normally, check this item.

[Connection
Test]

Click this button to test the connection to the
server with the settings entered in the [Server
settings] dialog box.

POINT

¢ To use the product in stand-alone with K2 Summit, set

the K2 Summit C: drive to be used for the network drive
of the Client PC. Check [Show only SNFES drivers] in the
[Server settings] dialog box, and then select the assigned
drive from the [Mapped Path] list.

User Guide
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[Cinema RAW]
» [GPU]

If there are supported GPUs, perform playback acceleration using
hardware.

[Sony Raw]
“ [GPU]

If there are supported GPUs, perform playback acceleration using
hardware.

QuickTime

MPEG
» MxF
1
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Specifying and Converting a File

Section

XRE Transcoder Operations

Note ¢ Perform the initial settings of XRE Transcoder in advance
according to Section 4 - XRE Transcoder Settings.

Specifying and Converting a File

XRE Transcoder —

On the PC for XRE Transcoder, specify a desired file and request
conversion process (transcoding job) to the XRE Service.

Note * Make sure that the XRE Service/Engine is started up.

¢ Confirm that the project folder of the XRE system can be
referenced from the PC. In addition, make sure that the
explorer of the project folder shows the same address as
those of the XRE Service and Engine.

¢ For details on the supported formats and restrictions, see
Section 6.
Appendix»P115

e [f the file output destination after conversion is an FTP
server or K2 Media server, set the output destination in
advance in the plug-in settings.
Plug-in settings» P22

o If the file output destination after conversion is an
external device, connect the external device to the PC for
Engine, and confirm that the power is turned on.

STEP 1: Registering Export Presets

Before converting a file, you need to register the export setting as an
export preset in advance.

1 Double-click the XRE Transcoder icon on the desktop.

2

XRETranscoder:

Alternative
¢ From the start menu, click [Grass Valley] > [XRETranscoder].
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2 Click [Setting] on the menu bar, and click [Export Preset
Settings].

®H XRE Transcoder

Eile Action Setting

rH s Setting... 3
#}u Plug-in Settings...

M Job nami Status  Priority  Submitted

Watch Folder Settings...
Export Preset Settings...

Project Template Settings...

The [Export Preset Settings] dialog box appears.
[Export Preset Settings] Dialog Box» P36

3 Click [Add].

Name:
Exporter:

Cancel

The [Print to File] dialog box appears.
[Print to File] Dialog Box» P37
5 Click a category in the category tree, and select an exporter.

See "Section 6" for the output formats and exporter list.

Output format»P117

Exporter

Windows Media

E WindowsMediaVideo WindowsMediaVideo Exporter Plug-in

ediaAudio Exporter Plug-in
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6 Click the expand button of [Advanced], and configure the
settings such as file size (frame size, frame rate, etc.) of the
export file.

[Print to File] (Detailed Settings) Dialog Box» P39
7 Click [OK].
The [Detail setting] dialog box appears.

8 Change the export preset name as necessary.

Name

Description WindowsMe o Exporter Plug-in

9 Make output settings in the [Detail setting] dialog box.
The setting items will differ depending on the exporter.

Output Setting for Each Format» P65

10 Click [OK], and then click [OK] in the [Export Preset Settings]
dialog box.

POINT  ° Toreconfigure the export settings, click [A] beside [...] of
the [Export Preset Settings] dialog box, and then click
[Select] or [Detail].

11 Click [Close] in the [Export Preset Settings] dialog box.
To convert a file, proceed to the following step.
STEP 2: Specifying and Converting a File» P45

XRE Transcoder — User Guide 35



Section5 — XRE Transcoder Operations

36

POINT ° A project template can be applied at file conversion.
Create a project template on EDIUS and import the
template file to XRE Transcoder in advance.
Applying a Project Template at Conversion» P53

+ [Export Preset Settings] Dialog Box

(1) Q) @) ©) ©6) ™)

(1) [Add] Create a new export preset.

(2) [Modify] Modify the configuration of the export preset
selected in the preset list.

(3) [Copyl Create a new export preset based on the
preset selected in the preset list.

(4) [Delete] Delete the export preset selected in the preset
list.

(5) [Refresh] Refresh the preset list.

(6) Preset list Display a list of created export presets.

(7) Information Display the detailed information of a preset

selected in the export preset list.
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Specifying and Converting a File

+ [Print to File] Dialog Box

()

Exporter

E WindowsMediaVideo WindowsMediaVideo Exporter Plug-in

4 WindowsMediaAudio WindowsMediaAudio Exporter Plug-n

(6) 7

(1) Category tree

Select a category to narrow down the exporter
options.

[Current default]
Display the default exporters.

[Recently used]
Display exporters in a list in the order of most
recently used first.

[My presets]
Display the exporter presets registered by the
user in a list.

[All]

Display all exporters in a list. You can narrow
the exporter options by selecting a category
by format.

(2) Exporter/Preset
list

Display the exporters within a selected
category in a list.

[Preset]
Display exporter presets stored as default and
exporter presets stored by the user.

H: Video exporter
Indicates exporters to export a file that
includes a video element.

dq: Audio exporter
Indicates exporters to export an audio element.
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(3) [Search]

Search the exporters.

(4) [Advanced]

Click the expand button to configure
conversion processing when exporting in a
format that differs from the source file.
[Print to File] (Detailed Settings) Dialog Box» P39

(5) [Save as
default]

Save four items for [Current default].
The saved exporters are displayed in [Current
default] of the category tree.

(6) Preset operation
buttons

B : [Save preset]

Register the exporter selected in the exporter/
preset list together with the conversion
processing configured under [Advanced] as a
preset exporter.

& : [Delete preset]

Delete the preset exporter selected in the
exporter/preset list.

The only exporter presets that can be deleted
are those that have been registered by the user.

21 : [Import preset]
Import exporter presets.

% : [Export preset]
Export the preset exporter selected in the
exporter/preset list.

(7) [OK]

Output according to the configured settings.
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+ [Print to File] (Detailed Settings) Dialog Box

If a preset exporter was selected, you will switch to the export format
settings of that preset exporter.

[z WindowsMediavideo WindowsMediaVideo Exporter Plug-n
d

[ iaAudio iaAudio Exporter Plug-n

it Depth

Frame Rate

Field Order

Frame Size Source setting

Aspect Ratio Source display aspect

Frame Rate Source setting

Field Order Auto

Drop frame

Checking [Change Video Format] exports files converting to the video
format set in the following items.

(1) Video profile Display a list of commonly used video

list formats. When you select a video format from
the list, [Frame Size] and other items will
switch to the selected video format settings.
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(2) [Frame Size]

Select a frame size from the list. Select
[Custom] to enter a setting value in pixels.

(3) [Aspect Ratio]

Select an aspect ratio from the list. If you
select [Custom Display Aspect] or [Custom
Pixel Aspect Ratio], you can set the aspect
ratio by entering values. If you have set a
customized aspect ratio, make sure to select
a conversion method from the aspect ratio
conversion setting.

(4) Aspect ratio
conversion
settings

If the aspect ratio set in [Aspect Ratio] differs
from the source file, select which method to
use to convert the aspect ratio from the list.
Setting the Aspect Ratio Conversion» P43

(5) [Crop Overscan
Area]

Check this item to convert the aspect ratio after
cropping with the overscan size. The overscan
size differs according to the source file.

(6) [Frame Rate]

Select a frame rate from the list. If you have
set a customized frame rate, be sure to
select a conversion method in the frame rate
conversion settings.

(7) Frame rate
conversion
settings

If the frame rate set in [Frame Rate] differs
from the source file, select from the list which
conversion to perform.

If you select [Frame blending], supplemental
frames will be interpolated by combining the
frame before and after each supplemental
frame. If you select [Nearest frame],

the nearest frame will be used to make
supplementary frames.

(8) [Field Order]

Select a field order from the list. If you select
[Auto], the optimum perceived field order will
be selected automatically.

(9) [Default TC
Mode]

Select whether the video to be exported
displays the drop frame timecode or the non
drop frame timecode as default.

(10) [Channel]

This can be set when an exporter to which the
alpha channel is retained and can be output
to is selected.

Select whether to output only the color
channel or to output the color channel and the
alpha channel.

40
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> Setting [Change Audio Format]

Checking [Change Audio Format] changes the audio format so it is
exported with the below-described items.

[Channels]

Select the number of channels from the list. If the
selected number of channels is fewer than the
source file, the channels will be exported in order
from 1ch. Select [2ch] to export a multi-channel
source file to be used with software of another
company.

[Sampling Rate]

Select a sampling rate from the list.

[Sample
Format]

Select an audio quantization bitrate from the list.
Select [16bit] to export a multi-channel source file
to be used with software of another company.

[Export Audio]

Check this item to export the audio part.

[Create
Waveform Cache]

Check this item to create waveform cache
(waveform representation of audio).

> [Remove Ancillary datal

This can be set when a compatible exporter is selected. Check this item
to export with ancillary data (including closed captions) removed.

Note e Even if it is unchecked, when the frame size, after the
frame rate or aspect ratio is corrected, is different from
that of source file, ancillary data will be removed.

> [Remove Audio Bitstream]

This can be set when a compatible exporter is selected. Check this item
to export with the audio bitstream removed.

Note e Even if this item is unchecked, when the frame rate or
audio sampling rate differs from that of the source file,

audio bitstream will be removed.

XRE Transcoder — User Guide
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> [Normalize Loudness] setting

Checking this item enables to measure the loudness and perform
normalization at the same time when you export a file.

For normalization, the volume can be adjusted according to a
predefined loudness reference value.

v Normalize Loudness

(1) Loudness Select the preset to use as the reference for
reference value | loudness measurement and normalization.

(2) [Outputreport | Check this item to export the loudness

file] adjustment details and measurement result
values of the target file to a text file.
The text file will be saved in the project
folder of XRE system. If project files are to be
exported to FTP or some other destinations,
they will be saved in the “Log” folder in the
project folder.

POINT ° Clicking [Save preset] in the [Print to File] dialog box
will create an exporter preset that contains the setting
details of [Normalize Loudness].

Note ¢ If the audio of the project to be normalized is muted
or low, after a message [The audio adjustment level is
too large.] is displayed, export may be canceled. This is
performed to prevent low-volume sound such as noise
from being unintentionally adjusted louder.

* Normalization is only applied to source files with audio
sampling rate 48 kHz. For sources with a sampling rate
other than 48 kHz, normalization can be performed by
first applying the project template set to “48kHz" for
[Audio Preset] in the [Project Settings] (Detailed Settings)
dialog box, and then converting it.

Applying a Project Template at Conversion» P53
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Specifying and Converting a File

> Setting the Aspect Ratio Conversion

For the items in the list of the aspect ratio conversion setting to be set
in the [Print to File]/[Print to File] (Detailed Settings) dialog box, what
follows are example descriptions of converting a 16:9 screen to a 4:3
screen, and a 4:3 screen to a 16:9 screen.

Original
screen
Item — Description
Converted
screen
Letter box / | 16:9 — 4:3 | The 16:9 screen is displayed in the center
Side panel of a 4:3 screen, and a letter box effect is
added above and below.
o]=[e
4:3 — 16:9 | The 4:3 screen is displayed in the center
of a 16:9 screen, and side panels are
added at the edges.
o el
Side cut / 16:9 — 4:3 | The left and right sides of the 16:9 screen
Crop top are cropped to fit the 16:9 screen to a 4:3
and bottom screen size.
0]=1[0
4:3 — 16:9 | The top and bottom parts of the 4:3
screen are cropped to fit the 4:3 screen to
a 16:9 screen size.
O = 0O
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Original
screen
Item — Description
Converted
screen
Anamorphic | 16:9 — 4:3 | The 16:9 screen is compressed
horizontally to fit a 4:3 screen size. The
frame aspect ratio is not conserved.
O |= |0
4:3 — 16:9 | The 4:3 screen is stretched horizontally
to fit a 16:9 screen size. The frame aspect
ratio is not conserved.
O| = O
Semi- 16:9 — 4:3 | The 16:9 screen is cropped to a 14:9 or
letter box 13:9 screen size, displayed in the center
(14:9/13:9) of a 4:3 screen and a letter box effect is
added above and below.
O =0 |= O
4:3 — 16:9 | The 4:3 screen is cropped to a 14:9 or 13:9

screen size, displayed in the center of a
16:9 screen and side panels are added at
the edges.

Q=0 |=|0]
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STEP 2: Specifying and Converting a File

Before converting a file, you need to register the export setting as an

export preset in advance.
STEP 1: Registering Export Presets» P33
1 Click [Add job] on XRE Transcoder.

Alternative
¢ Click [File] on the menu bar, and click [Add job].

[New Job] dialog box appears.

2 Click [...] of [Source File], and select a source file.

Export Preset:

Exportin 16bit/2ch

Qutput File:

3 To apply a project template at the time of conversion, check
[Project Template], and select a project template from the list.

To apply a project template, the project template file must be imported
to the project template settings of XRE Transcoder in advance.

STEP 2: Import the Project Template to XRE Transcoder» P54
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4 Click on the [Export Preset] list and select an export preset to
apply to file to be converted.

Source File: iy -5V56433%¥Work_Data¥Grass Valley¥XRE Transcoder_9. 3¥test¥source_f | ...

WindowsMediaVideo 1

*) This preset supports

Qutput File:

POINT ° Anexport preset with a * mark on the right supports
conversion of a source file that is currently being recorded.
¢ Checking [Display Timecode] records the timecode same

as that of the source file to the converted export file.

¢ Checking [Restripe Timecode] records timecode which
differs from that of the source file to converted the export
file. Select the timecode to be recorded from [From
Source First Timecode] and [From Custom Timecode]. If
you select [From Custom Timecode], enter a timecode.

* Checking [Export in 16bit/2ch] exports a file in 16-bit/2ch,
regardless of the audio format of the source file or
selected export preset. It is convenient to leave it checked
when a multi-channel source file is to be exported and
used with software by another manufacturer.

5 Click [...] of [Output File], specify an output destination and
file name, and then click [Save].

Export in 16bit/2ch

Qutput File:

46 XRE Transcoder — User Guide



Converting a File Automatically (Watch folder function)

Note o If the file output destination after conversion is a desired
folder, you need to specify a folder that can be referenced
from all of the PCs for XRE Transcoder/XRE Service/
Engine and that shows an identical address on the
explorer.

6 Click [OK] on the [New Job] dialog box.

The transcoding job is registered to XRE, and the conversion process
is performed. The progress status of the conversion process can be
checked in the job list of XRE Transcoder.

Checking job status»P109

Converting a File Automatically (Watch folder function)

You can configure the settings so that a file is requested to be
automatically processed for format conversion (as a transcoding job)
once it is added in the Watched folder.

The procedures to configure the Watch folder (Watched folder, output
destination after conversion, and output setting) on the PC for XRE
Transcoder are described.

Note * Make sure that the XRE Service/Engine is started up.

¢ Confirm that the project folder of the XRE system can be
referenced from the PC. In addition, make sure that the
explorer of the project folder shows the same address as
those of the XRE Service and Engine.

¢ For details on the supported formats and restrictions, see
Section 6.
Appendix»P115

¢ [f the file output destination after conversion is an FTP
server or K2 Media server, set the output destination in
advance in the plug-in settings.
Plug-in settings» P22

* When you use the Watch folder function, files (such
as P2 MXE, etc.) that have folder structures cannnot be
converted.

* When you use the Watch folder function, an external
device cannot be specified as the output destination.

1 Double-click the XRE Transcoder icon on the desktop.
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Alternative
¢ From the start menu, click [Grass Valley] > [XRETranscoder].

2 Register an export preset.

STEP 1: Registering Export Presets» P33
3 Click [Setting] on the menu bar, and click [Watch Folder
Settings].

®H XRE Transcoder

Eile Action Setting

r‘ a Setting...

%
#m Plug-in Settings...

M Job nami Status  Priority  Submitted

Watch Folder Settings...
wport Preset Settings...

Project Template Settings...

[Watch Folder Settings] dialog box appears.
[Watch Folder Settings] Dialog Box» P52

4 Click [Add].

Watch Folder Settings

ﬂ%o

O... Mame & Watched Folder Path Information

[Watch Folder Settings] dialog box appears.
5 Enter the Watch folder name in [Name].
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6 Click [...] of [Watched Folder] to select a folder to be watched.

Check [Include Subfolders] to include subfolders in the Watch folder as
conversion target.

Output:

Note ¢ For the Watched folder, you need to specify a folder
that can be referenced from all of the PCs for XRE
Transcoder/XRE Service/Engine and that shows an
identical address on the explorer.

7 To apply a project template at the time of conversion, check
[Project Template], and select a project template from the list.

To apply a project template, the project template file must be imported
to the project template settings of XRE Transcoder in advance.

STEP 2: Import the Project Template to XRE Transcoder» P54

8 Click on the [Export Preset] list and select an export preset to
apply to the file to be converted.

WindowsMediaVideo1

Preserve relative path
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POINT ° Anexport preset with a * mark on the right supports
conversion of a source file that is currently being
recorded.

¢ Checking [Display Timecode] records the timecode same
as that of the source file to the converted export file.

¢ Checking [Restripe Timecode] records timecode which
differs from that of the source file to converted the
export file. Select the timecode to be recorded from
[From Source First Timecode] and [From Custom
Timecode]. If you select [From Custom Timecode], enter
a timecode.

* Checking [Export in 16bit/2ch] exports a file in 16-bit/2ch,
regardless of the audio format of the source file or
selected export preset. It is convenient to leave it checked
when a multi-channel source file is to be exported and
used with software by another manufacturer.

9 Click[...] of [Output] to set the output destination.

To output subfolders of the Watch folder in the same folder structures,
check [Preserve relative path].

Watch Folder Settings

Name:

Watched Folder: D-5\ ) V¥XRE Transcoder_9. 3¥test¥Watch_Folder

Export Preset:

Export in 16bitf2e

Output:

Note * You need to specify a folder that can be referenced from
all of the PCs for XRE Transcoder/XRE Service/Engine
and that shows an identical address on the explorer.
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10 Click [OK] in the [Watch Folder Settings] dialog box.

11 In the [Watch Folder Settings] dialog box, select the check box
of the Watch folder setting to activate.

12 Click [Close].

If a file is added to the Watched folder while XRE Transcoder is
running, the transcoding job will be registered to XRE. Then the
conversion process will be performed. The progress status of the
conversion process can be checked in the job list of XRE Transcoder.

Checking job status»P109

POINT * Watch folder settings will be maintained when the XRE
Transcoder is restarted.
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+ [Watch Folder Settings] Dialog Box

(1) Q) @) ©)

(1) [Add]

Create a new Watch folder.

(2) [Modify]

Modify the configuration of the Watch
folder selected in the folder list.

(3) [Copyl

Create a new Watch folder based on the
Watch folder settings selected in the
folder list.

(4) [Delete]

Delete the Watch folders selected in the
folder list.

(5) [Refresh]

Refresh the folder list.

(6) Watch folder list

Display the list of created Watch folders.
Checked Watch folder is enabled.

(7) Information

Display the detailed information of a
Watch folder selected in the folder list.

52

XRE Transcoder — User Guide



Applying a Project Template at Conversion

Applying a Project Template at Conversion

You can apply a project template created on EDIUS when converting a
file with XRE Transcoder.

Project templates can be applied also in the conversion process using
the Watch folder function.

For more information on how to operate EDIUS, refer to the EDIUS
manual.

STEP 1: Create a Project Template on EDIUS

1 Create a project template on EDIUS.

Place a clip named “#placeholder” on the timeline and make effect and
layouter settings.

At the time of conversion with XRE Transcoder, the part
“#placeholder” will be replaced by the conversion target file.

Editing Example of Project Template (Watermark)» P57
Editing Example of Project Template (Sidebar Blur) »P59

Editing Example of Project Template (Playback Speed Change)» P62
Example) Editing example of timeline

|
| .

8 #placeholder [E]

#placeholder

Insert Mode  Ripple Off =] Disk :27% is being used(D:)

Note * The number of audio channels of the project template

must be more than that of the file to be converted.

* You need to place audio tracks and set the channel map.
This setting will be used for conversion.

¢ The duration of “#placeholder” on the timeline must be
shorter than the length of the file to be converted.
When the file is converted with XRE Transcoder, the
duration of “#placeholder” will be expanded along with
the duration of the file to be converted.
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2 Click [Save Project] for EDIUS, and then click [Save As
Template], to save the file to a specified location.

%- w. (@) X

Sequence E

Shift + Ctrl + §

Template...

Consolidate Project...

Export Project

Project Settings...

Seguence Settings...

Save the file in a folder that can be accessed from the PC where XRE
Transcoder has been installed, XRE Service, and all Engine PCs, which
shows the same address on the explorer.

STEP 2: Import the Project Template to XRE Transcoder
1 Double-click the XRE Transcoder icon on the desktop.

&

XRETranscoder

Alternative
* From the start menu, click [Grass Valley] > [XRETranscoder].

2 Click [Setting] on the menu bar, and click [Project Template
Settings].

® XRE Transcoder
Eile Action Setting
L

N Job nam

F Setting...

[
S oo
% Plug-in Setfings.. s Priority  Submitted
Watch Folder Settings

Exp

Project Template Settings...

The [Project Template Settings] dialog box appears.
The [Project Template Settings] Dialog Box» P56
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3 Click [Add].

Project Template Settings

ﬁ%o

Name & Information

4 Enter the name of the project template in [Name)].

Project Template:

Name: template_1

Project Template:

6 Click [OK] in the [Project Template Settings] dialog box.

£

7 Click [Close] in the [Project Template Settings] dialog box.
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% The [Project Template Settings] Dialog Box

(1) Q) @) ©) ©6) ™)

(1) [Add] Create a new project template.
pTOj P

(2) [Modify] Modify the configuration of the project
template settings selected in the template
list.

(3) [Copyl Create a new project template based on
the project template setting selected in
the template list.

(4) [Delete] Delete the the project template selected
in the template list.

(5) [Refresh] Refresh the template list.

(6) Template list Display a list of created project

play proj
templates.

(7) Information Display the detailed information of a

play
project template selected in the folder
list.

STEP 3: Convert File with the Project Template

For the procedure to convert a file, see the following sections.
Specifying and Converting a File»P33

Converting a File Automatically (Watch folder function) » P47
The part “#placeholder” of the project template will be replaced by the
conversion target file.
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Editing Example of Project Template (Watermark)

In this section, the procedure to add a watermark (still image) on the upper
right is described as an example of project template editing on EDIUS.

After conversion with project

Before conversion template applied

*d00:00:00;00% n 4 rd00:00:00;00+ n

1 Register a temporary video file to the bin with the name
“#placeholder”.

2 Place the “#placeholder” clip in step 1 on the 1VA track of the
timeline.

Set the duration of the clip shorter than that of the file to be converted.

3 Register a watermark image to the bin.

Note * Since the watermark image is used when a file is converted,
save the file in a folder that can be accessed from all PC/
XRE Service/Engine where XRE Transcoder has been
installed, which shows the same address on the explorer.

4 Place the watermark image on the 2V track of the timeline.

5 Select clips on the 1VA track and 2V track, right-click on them,
and click [Link/Group] > [Set Group].

The “#placeholder” clip and watermark image clip will be set as group.
(This stretches the clip on the 2V track so that it is synchronized with
the “#placeholder” clip.)

6 Select the clip on the 2V track, and double-click [Layouter] in
the [Information] palette.
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7 Click the [Transform] tab and drag the operation handle
in the preview window, to adjust the size of the watermark
image.

9 Click [OK] on the [Layouter] dialog box.

Editing operation has been completed.
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Editing Example of Project Template (Sidebar Blur)

In this section, the procedure to add blur that look natural at both
sides of a portrait-oriented video shot with a smartphone etc. is
described as an example of project template editing on EDIUS.

After conversion with project

Before conversion template applied

red00:00:00;00%* 1 #d00:00:00;00* 1

1 Register a temporary video file shot with a smartphone etc. to
the bin with the name “#placeholder”.

2 Place the “#placeholder” clip in step 1 on the 1VA track of the
timeline.

Set the duration of the clip shorter than that of the file to be converted.

3 Select the “#placeholder” clip on the timeline, and double-
click [Layouter] in the [Information] palette.

$roaron

[Layouter] dialog box appears.
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4 Click the [Transform] tab and drag the operation handle in the
preview window, to enlarge the image to the right and left edges.

5 Click [OK] on the [Layouter] dialog box.

6 Apply [Blur] on the [Effects] palette onto the “#placeholder”
clip (video part) on the timeline.

EDIUS File Edit View Ciip Marker Mode Capture Render »

el #pisceholder

7 Double-click [Blur] in the [Information] palette.
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8 Adjust the blur appearance in the [Blur] dialog box and click
[OK].

Red00:00:00;00 =

In--:-:-=3--  Dut--:i--:i--;-- Du

. P. B« () » G,
EDIUS Untited4

+~ 83 Cl -1

9 Place the “#placeholder” clip in step 1 on the 2V track of the
timeline.

Editing operation has been completed.
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Editing Example of Project Template (Playback
Speed Change)

In this section, the procedure to modify the speed is described as an
example of project template editing on EDIUS.

1 Register a temporary video file to the bin with the name
“#placeholder”.

2 Place the “#placeholder” clip in step 1 on the 1VA track of the
timeline.

Set the duration of the clip shorter than that of the file to be converted.

3 Right-click on the “#placeholder” clip on the timeline, and
click [Time Effect] = [Speed].

EDIUS Untitied4

.

e

4 Modify each item in the [Speed] dialog box.

< [Speed] Dialog Box

Speed
Direction & forward backward

Rate

+ Change the Clip Duration on Timeline

Duration:

Field Option... OK Cancel

[Speed] [Direction]
Select the playback direction of the clips.
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[Rate]

Enter the ratio to the original speed (100%).
Since the speed is changed referenced to the
In point, when [Change the Clip Duration on
Timeline] is unchecked, the upper limit of
Rate that can be entered changes according
to the margin on the Out point side of the
source clip. When there is no margin on the
Out point side, a Rate greater than 100%
cannot be entered.

[Change the Check this item to change the duration of
Clip Duration on clips on the timeline according to the speed
Timeline] (value of [Rate]) of the clip. The duration

of the clip can be entered at [Duration] to
change the speed.

When this item is unchecked, the speed can
be changed without changing the duration of
the clip on the timeline.

[Field Option] The [Field Option] dialog box appears.
[Field Option] Dialog Box» P63

+ [Field Option] Dialog Box

Interpolation Method
Nearest neighbar
® Frame blending

Optical flow

Processing Option

when speed is below 100%

Always deinterlace

MNone

Save as default

[Interpolation [Nearest neighbor]

Method] The length of the clip is adjusted by skipping
frames or continuously displaying the same
frame.
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[Frame blending]

Adjacent frames are composed and a
new frame is automatically generated to
interpolate between the frames.

[Optical flow]

The motion in adjacent frames are analyzed
by pixels and a new frame is automatically
generated so that the motion of the subject is
played back smoothly.

[Processing Option] | Set the processing option to reduce flicker
during slow motion. Set [Deinterlace when
speed is below 100%] when video is affected
by the scanning line and flickers when a
slower playback speed has been set.

[Save as default] Click this item to save the current settings
as defaults. When a clip is placed on the
timeline, the default [Field Option] is always
applied.

5 Click [OK].

Editing operation has been completed.
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Output Setting for Each Format

The output setting screens for each format are described.
In this section, the output setting in “STEP 1: Registering Export
Presets” step 9 is explained.

Note * When you use the Watch folder function, an external
device cannot be specified as the output destination.

Windows Media Video Format

Category name in [Print to
File] dialog box Exporter
[Windows Media] [WindowsMediaVideo]

% [WindowsMediaVideo] Exporter

2000

Audio settings

v Mode CER

kbps (4~20000) Bitrate 178 v kbps

image quality
{100)

[Video settings]

[Mode]

[CBR] is a fixed transfer mode. It encodes with a
constant bitrate regardless of movement or image
complexity. Enter a value for [Bitrate].

[CBR (2-pass)] performs encoding after an analysis
for movement and image complexity.

[VBR (quality based)] is a variable transfer mode
of direct conversion. The allotted bitrate is varied
according to movement and image complexity.
Enter a value for [Quality].

[VBR (2-pass)] is a variable transfer mode. The
allotted bitrate is varied after an analysis of
movement and image complexity. Enter the average
bitrate in [Bitrate], and maximum bitrate in [Max].
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[Frame rate]
Check this item to change the frame rate (1-60 fps).
To set to 29.97 fps, enter “2997”.

[Picture size]

The image size can be set by selecting from

the list. Checking [Square pixel] sets the image
aspect ratio at 1:1. Check this if the video is
made vertically long or horizontally long by the
playback device.

[Quality setting]

Move the slider depending on the relative
importance of [frame rate (0)] (prioritizes smooth
movement) and [image quality (100)].

[Audio settings] | [Mode]

[CBR] is a fixed transfer mode. It encodes with a
constant bitrate regardless of audio complexity.
Select a bitrate from the [Bitrate] list.

[CBR (2-pass)] performs encoding after an analysis
for audio complexity.

[VBR (quality based)] is a variable transfer mode.
The allotted bitrate is varied according to audio
complexity. Select an average bitrate from the
[Quality] list.

AVI Format

Category name in [Print to
File] dialog box

Exporter

[AVI]

[Grass Valley HQ AVI]
[Grass Valley HQX AVI]
[Grass Valley Lossless AVI]
[DV AVI]

[DVCPROS50 AVI]

[DVCPRO HD AVI]
[Uncompressed (RGB) AVI]
[Uncompressed (RGBA) AVI]
[Uncompressed (UYVY) AVI]
[Uncompressed (YUY2) AVI]
[Uncompressed (v210) AVI]
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% [Grass Valley HQ AVI] / [Grass Valley HQX AVI] Exporter

Custom

Codec settings [Online(SuperFine)]

This item can be selected for a Grass Valley
HQX codec. This setting provides the highest
image quality, though the file size increases.
Select this when importing at high image
quality is needed.

This item cannot be selected for a Grass Valley
HQ codec.

[Online(Fine)]

This setting provides high image quality,
though the file size increases. Select this when
importing at high image quality is needed.

[Online(Standard)]
Normally, you can get sufficient image quality
at this setting.

[Offline]
Select this item to encode at a lower bitrate.

[Custom]

[Q] and [Max size] can be adjusted.

[Q] adjusts image quality. Set within the range 4 to
19 (0 to 18 in the case of a Grass Valley HQX).Setting
a smaller value results in higher image quality.
[Max size] sets the maximum bitrate. You

can set to limit the file size that increases
inadvertently as a result of excessive noise in
the video. Setting value “100” % means the
same bitrate before codec compression. For
example, 100% for 1440x1080 59.94i is a bitrate of
approximately 750 Mbps. To set the upper limit
to 200 Mbps, set “27” % as the maximum size.
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< [DV AVI] Exporter

If [Use MSDV codec] is checked, it will export as AVI with the MSDV
codec.

Audio Format

Category name in [Print to
File] dialog box Exporter
[Audio] [Dolby Digital (AC-3)]
[PCM AIFF]
[PCM WAVE]
[Sony/Sonicfoundry Wave64]
[Windows Media] [WindowsMediaAudio]

< [Dolby Digital (AC-3)] Exporter
Select a bitrate from the [Format] list.

¢ [WindowsMediaAudio] Exporter

Select the transfer mode. If [CBR] (fixed transfer mode) has been
selected, select a bitrate from the [Bitrate] list. If [VBR (quality based)]
(variable transfer mode) has been selected, select a bitrate from the
[Quality] list.

Dolby Digital Professional or Dolby Digital Plus Format

Category name in [Print to

File] dialog box Exporter

[Audio] [Dolby Digital Professional (AC-3)]
[Dolby Digital Plus (E-AC-3)]

+ [Dolby Digital Professional (AC-3)1/ [Dolby Digital Plus
(E-AC-3)] Exporter

Format 2 chaninel - 256kbps

[Format] Select the number of bits.

[Settings] Set bitstream details.
[Dolby Setting] Dialog Box» P70
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> Assigning output channels
Output channels are assigned to the front left (L), front right (R), front
center (C), LFE, rear left (Ls), and rear right (Rs), in the order of the
smallest channel number. (Channels that are not used will be skipped.)
When the single rear (S) is to be used, the rear left (Ls) is assigned.

Output Setting for Each Format

Example:
When [Audio Coding Mode] in the [Dolby Setting] dialog box is set to
[2/0]
[Dolby Setting] Dialog Box» P70
[Audio Coding | [LFE Stream to be assigned
Mode]  |Channel]*| | R c LFE | Ls Rs S
[1/0] — — — | Chl | — — — —
[2/0] — Chl | Ch2 | — — — — —
[2/1] — Chl | Ch2 | — — — — | Ch3
O Chl | Ch2 | — | Ch3 | — — | Ch4
[2/2] — Chl  Ch2  — — | Ch3  Ch4  —
O Chl | Ch2  — | Ch3 Ch4 | Ch5 | —
[3/0] — Chl | Ch2 Ch3  — — — —
O Chl  Ch2 | Ch3  Ch4  — — —
[3/1] — Chl | Ch2 Ch3  — — — | Ch4
O Chl | Ch2 | Ch3  Ch4 — — | Ch5
[3/2] — Chl  Ch2 Ch3 — | Ch4 | Ch5| —
O Chl | Ch2 Ch3 Ch4 Ch5 | Ch6 | —

* O indicates that [LFE Channel] in the [Dolby Setting] dialog box is

checked.
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> [Dolby Setting] Dialog Box

Mot surround encoded

105 dB
-31dB
Complete Main
Small

e control profile Film Standard

Standard

+ Original bitstream

[Audio Coding Specify the audio channel (front left (L), front
Mode] center (C), front right (R), single rear (S) rear left
(Ls), rear right (Rs)).

Select an option from [1/0] (C only, monaural),
[2/0] (L/R, stereo), [2/1] (L/R/S), [2/2] (L/R/Ls/Rs),
[3/0] (L/C/R), [3/1] (L/C/R/S), [3/2] (L/C/R/Ls/Rs).
The items where the number of channels exceeds the
audio channels in the source file cannot be selected.

[LFE Channel] Check this item to export including LFE channel.
When [Audio Coding Mode] is set to [1/0] or [2/0],
it cannot be selected.

[Dolby Surround Set Dolby surround or Dolby Digital surround EX.
Mode]/[Dolby When [Audio Coding Mode] is set to [1/0] or [2/1],
Surround Mode EX]" | it cannot be selected.
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[Stereo
Downmix
Preference]

Can be set when [Audio Coding Mode] is set to
[3/0], [3/1], or [3/2].
[Not indicated]

Dolby surround mode is not specified.

[Lt, Rt]
Downmix to audio compatible with Dolby
surround.

[Lo, Ro]
Downmix to audio compatible with stereo or
monaural playback.

[Pro Logic Il
Downmix in the Dolby Digital Pro Logic II format.
For Dolby Digital Professional, it cannot be set.

[Center Mix
Level]

Can be set when [Audio Coding Mode] is set to
[3/0], [3/1], or [3/2].

Select a value to downmix the center channel
when the playback device does not have the center
channel and stereo playback is to be performed.
Selecting [-INF dB] deletes the center channel.

[Surround Mix
Level]

Can be set when [Audio Coding Mode] is set to
[2/1], [2/2], [3/1], or [3/2].

Select a value to downmix the surround channel
when the playback device does not have the
surround channel and stereo playback is to

be performed. Selecting [-INF dB] deletes the
surround channel.

[Peak mixing
level]

Specify the peak sound pressure level (SPL) in
the environment where the final mixing has been
performed (such as a studio or dubbing stage).
Select from [111 dB] to [80 dB].
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[Dialog
Normalization]

Specify the average audio level of the bitstream.
Specifying this value enables playback of multiple
audio with the same level on the playback device.
Select from [-31 dB] to [-1 dB].

The difference between the selected value and

31 dB is the attenuation when the audio is played
back on a playback device. Select the audio level
[-31 dB] from the edited file.

Example:

For audio of average —6 dB

Set [-6 dB]. The attenuation will be 31 dB - 6 dB =
25 dB.

Example:

For audio of average —12 dB

Set [-12 dB]. The attenuation will be 31 dB — 12 dB
=19 dB.

[Bitstream Mode]

Set the audio service included in the bitstream.

[Room typel

Specify the information on the environment
where the final mixing has been performed (such
as a studio or dubbing stage).

[Dynamic range
control profile]

Specify the dynamic range compression settings.
To use [Dynamic range control profile], configure
[Dialog Normalization] properly.

[A/D converter type]

Specify the digital conversion process.

[LFE lowpass
filter]

Check this item to enable the low-pass filter of the
LFE channel and to filter audio of 120 Hz or higher.

[90-degree Check this item to output in Dolby surround

phase shift] compatible audio when downmix playback of multi-
channel audio is performed on a 2-channel decoder.

[3 db attenuation] = Check this item to decrease the surround channel
by 3 dB when home theater equipment compatible
with multi-channel is used.

[Copyright bit] Check this item to specify that the output file
contains copyright-protected contents.

[Original Check this item to specify that the output file is

bitstream] not a copy but an original file.

*If [Audio Coding Mode] is [2/0], [Dolby Surround Mode] is set. If
[Audio Coding Mode] is [2/2], [3/0], [3/1], or [3/2], [Dolby Surround

Mode EX] is set.
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HDV Format

Category name in [Print to
File] dialog box

[HDV] [HDV]

Exporter

 [HDV] Exporter

Quality/Speed  Normal

[Segment Check this item to export a clip of a raw source
Encode] without re-encoding.

This increases the output speed.

If the frame rate of the export format is 23.98p,
segment encode is not available.

[Quality/Speed]

Select the quality of the part to be re-encoded
from the list. The higher the quality, the more
time it takes to be encoded.

[Gop Typel Only displayed when the export format frame rate
is 23.98p. Select the format from [HDV24p Record
(Canon XL-H1, Sony HVR-Z7 etc.)] or [HDV24p
Scan (Sony HVR-V1, HDV1080i devices)].

QuickTime Format

Category name in [Print to
File] dialog box 200G
[QuickTime] [Apple ProRes MOV]
[QuickTime]
[Grass Valley HQ MOV]
[Grass Valley HOX MOV]
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 [Apple ProRes MOV] Exporter

[Apple ProRes [Apple ProRes 422 HQ]

CODEC settings] High data rate Apple ProRes 422. The target
data rate for the source 1920 x 1080, 29.97 fps
is approximately 220 Mbps.

[Apple ProRes 422]

A format suitable for real time editing. The
target data rate for the source 1920 x 1080,
29.97 fps is approximately 147 Mbps.

[Apple ProRes 422 LT]
A format suitable for saving the disk storage.

The target data rate for the source 1920 x 1080,
29.97 tps is approximately 102 Mbps.

[Apple ProRes 422 Proxy]

A codec for offline workflow. The target data
rate for the source 1920 x 1080, 29.97 fps is
approximately 45 Mbps.

% [QuickTime] Exporter

Click [Settings].
For detailed settings of output to each file format, refer to the help of
QuickTime Player.

< [Grass Valley HQ MOV] / [Grass Valley HOX MOV]
Exporter

For the setting items, see the descriptions given for [Grass Valley HQ
AVI] / [Grass Valley HQX AVI] exporter.

[Grass Valley HQ AVI] / [Grass Valley HQX AVI] Exporter» P67
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POINT  ° If [Grass Valley HOX MOV] or [Grass Valley HQ MOV] is
set for the exporter, when a project template that satisfies
all the following conditions is applied, HDR metadata
will be added to the output data.

- When [Color Space] in [Project Settings] is set to
[BT.2020/BT.2100 HLG] or [BT.2020/BT.2100 PQ].

- When [Primary Color Correction] is applied, [Source] is
set to [Auto], and [Destination/LLUT] is set to [BT.2020/
BT.2100 HLG] or [BT.2020/BT.2100 PQ)].

BD Format

Category name in [Print to
File] dialog box

[H.264/AVC] [Blu-ray]

Exporter

+ [Blu-ray] Exporter
> [Basic Settings] tab

Audio Settings

= Dolby Digital Professi... *

Bit Rate :

12000000 + bps Setting...

Quality : Mormal

[Video settings] | [Profile]
Set the profile. The selectable profiles will differ
dependent on the frame size to be exported.

[Bit Rate Typel]
[CBR] assigns a constant number of bits. Although
noise, etc. may be present, the encoding process is
made quicker.

[VBR] changes the assigned bitrate according to
the complexity of the movement or image quality.
Compared with [CBR], the media volume can

be used more efficiently, and this enables more
consistent image quality overall.
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[Average]

Set this item if [CBR] or [VBR] has been selected as
the bitrate type. You can either select from the list
or enter values directly.

[Max]

Set this item if [VBR] has been selected as the
bitrate type. You can either select from the list or
enter values directly.

[Quality]
Select the image quality from the list.

[Use Hardware Encoder]

Check this item to output video using hardware
encoding such as Quick Sync Video.

Unchecking this item will output video using H.264
software encoder that enables high-quality and
high-speed encoding.

In an environment where hardware encoding is

not available, [Use Hardware Encoder] will not be
displayed. The encoder for output will be fixed to
H.264 software encoder.

[Audio settings] | [Format]
Select the audio compression format from the list.
¢ For [Dolby Digital (AC-3)] or [Dolby Digital
Professional (AC-3)]
If the number of audio channels in the source
file is 7ch or more, the 7th channel and later are
discarded, and the source file is output with
5.1ch - 1ch:L, 2ch:R, 3ch:C, 4ch:LFE, 5ch:Ls, and
6ch:Rs. If the number of audio channels in the
source file is 5ch or less, all except 1/2ch are
discarded and the source file is output with 2ch.
e For [Linear PCM]
If the number of audio channels in the source file
is 8ch, output is with 8ch; if the number is 6ch/7ch,
output is with 6ch; if the number is 4ch/5ch, output is
with 4ch: and if the number is 3ch, output is with 2ch.

[Bit Rate]
Select a bitrate from the list.

[Setting]
Set bitstream details.
[Dolby Setting] Dialog Box» P70
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> [Extended Settings] tab

1gs  Extended Settings

IDR Interval :
B Frame :
Mumber o ence Frames :

¥ Multi

Entropy Ceding Mode :

[IDR Intervall Enter the IDR frame interval, and set the GOP size.

[B Frame] Set the number of B-frames included in one GOP.
[Number of Set up to how many frames to consider when
Reference motion estimation is performed.

Frames]

[Multi Slice] Check this item to divide 1 frame into 4 parts. If

the decoder supports multi-slicing, the decoding
may be made quicker.

[Entropy Coding | Select the H.264 encoding mode.

Mode]

[Bit Depth]* Select a video quantization bitrate from the list.
[Chroma Select a YUV pixel format from the list.
Format]*

* Only available when the exporter is [H.264/AVC]. If [Blu-ray],
[AVCHD)], [F4V], or another exporter is to be used, [Bit Depth] is fixed
to [8], and [Chroma Format] is fixed to [4:2:0].

Note e If [Bit Depth] is set to [10], or [Chroma Format] is set to
[4:2:2], hardware encoding cannot be performed even
when [Use Hardware Encoder] check box is selected in
[Video settings].
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MP4 Format
Category name in [Print to
File] dialog box 200G
[H.264/AVC] [PlayStation Portable]
[H.264/AVC]
[iPod]

POINT  ° If [Bit Depth] is set to [10] in the [Extended Settings] tab
at the time of export, the file will be exported in 10-bit.

e If [H.264/AVC] is set for the exporter, when a project
template that satisfies all the following conditions is
applied, HDR metadata will be added to the output data.

- When [Color Space] in [Project Settings] is set to
[BT.2020/BT.2100 HLG] or [BT.2020/BT.2100 PQ]

- When [Primary Color Correction] is applied, [Source] is
set to [Auto], and [Destination/LUT] is set to [BT.2020/
BT.2100 HLG] or [BT.2020/BT.2100 PQ)].

< [PlayStation Portable] / [H.264/AVC] / [iPod] Exporter

For the setting items, see the descriptions given for [Blu-ray] exporter.

[Blu-ray] Exporter» P75
For [PlayStation Portable]/[iPod] exporter, [Size] can be changed in
[Video settings] of the [Basic Settings] tab.

MPEG-2 Format

Category name in [Print to
File] dialog box Exporter
[MPEG] [MPEG2 Elementary Stream]
[MPEG2 Program Stream]

% [MPEG2 Elementary Stream] / [MPEG2 Program
Stream] Exporter

If [MPEG2 Elementary Stream] has been selected, click [Select], set the
audio and video export destinations, and click [OK].
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> [Basic Settings] tab
The setting items displayed may differ in part depending on the

exporter.

Audio Settings

Format MPEG1 Audio Lay...

Current Setting  » Channel

Maximum{bps)

v Bit Rate (bps)

[Video settings]

[Segment Encode]

Check this item to export a clip of a raw source
without re-encoding.

This increases the output speed.

[Size]

Select an image quality.

[Quality/Speed]
Select quality from the list. The higher the quality,
the more time it takes to be encoded.

[Bit Rate]

Select a bitrate type.

[CBR] sets a fixed transfer rate, allocating a fixed
number of bits during the encoding process.
Select a bitrate from the [Average(bps)] list. You
can also enter a value directly.

[VBR] sets a variable transfer rate, altering the number
of assigned bits according to the complexity of the
movement or image quality. Compared with [CBR], the
media volume can be used more efficiently, and this
enables more consistent image quality overall. Select

a bitrate from the [Average(bps)] and [Maximum(bps)]
lists. You can also enter a value directly.

User Guide

79



Section5 — XRE Transcoder Operations

[Audio settings] | [Format]
Select the audio compression format from the list.

[Channel]

Select from [Stereo], [Dual Channel] or [Joint Stereo].
[Stereo] is normal stereo that records separately on

the left and right sides. If there is a large difference
between the left and right audio, compared to stereo
that saves audio with a greater focus on one side, [Dual
Channel] records totally independently so that there

is no bias in sound quality to one side. Select to enter
narration in 2 languages, etc. [Joint Stereo] improves
audio quality and compression ratio when recording
left and right audio separately by automatically using

a single channel that combines the audio when the left
and right sides are the same or one more channel when
the left and right audio are different.

[Bit Rate (bps)]
Select a bitrate from the list.

> [Extended Settings] tab

wtended Settings

Copyright Flag

Picture Count

Closed GOP

[Video settings] @ [Field Order]
For interlace, a field order can be selected.

[Chroma Format]
Select a YUV pixel format from the list.
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[Profile & Levell

Select a profile & level. If [Chroma Format] is
[4:2:0] and [4:2:2], the profile will be set to Main
Profile and 422Profile, respectively. The level for
SD image quality will be Main Level, and the level
for HD image quality will be High Level. The
profile & level changes according to the format
selected in [Chroma Format].

[GOP Structure]

For MPEG, a certain number of frames is
considered as a group, and operations such as
compression/enlargement and cut editing are
performed on a GOP basis. A GOP comprises “I
frame”, “P frame” and “B frame”. The I frame
allows images to be reproduced independently,
the P frame is for recording and reproducing only
the differences with the preceding image, and the
B frame reproduces images from the differences
in the preceding and following images. Select I,

P and B frame patterns of the GOP from the list.
Normally, select [IBBP].

[I-Frame Only] is comprised of only I-pictures.
Editing is made easier, but the amount of data
increases in size.

[Picture count]
Set the number of frames included in a group.

[Closed GOP]

Check this item to complete information within
each GOP. Although the amount of data increases,
the video can be re-edited using software that
supports GOP-based editing. Normally, leave this
item unchecked.
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[Audio settings] | [Emphasis]

Select from the list for high-frequency
compensation that saves while emphasizing

the high range. With [None], there is no high-
frequency compensation. [50/15 us] is an emphasis
setting employed by some audio CDs, etc.

[CCITT J.17] is a telecommunications standard
recommended by CCITT.

[Protection]

The “protection_bit” indicates whether
redundancy is added to an audio stream in order
to make error detection and correction possible.
Check this item to change it to “1”, indicating that
redundancy is being added. Uncheck this item to
change it to “0”, indicating that redundancy is not
being added.

[Original Flag]

Check this item to change the “original_copy”
bit to “1”, indicating the original copy. If it

is unchecked, it becomes “0”, indicating a
duplication.

[Copyright Flag]

Check this item to change the “copyright” bit to
“1”, indicating that the copyright is protected. If
it is unchecked, it becomes “0”, indicating there is
no copyright.

Flash Video (F4V) Format

Category name in [Print to
File] dialog box

[H.264/AVC] [FAV]

Exporter

< [F4V] Exporter

> [Basic Settings] tab/[Extended Settings] tab

For the setting items, see the descriptions given for [Blu-ray] exporter.

[Blu-ray] Exporter» P75
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> [Metadata] tab

gs  Metadata

Metadata

MName

[Export Check this item to export sequence markers as cue
sequence marker | points for Flash. Select the name of the type of cue
as cue point] point.

[Metadatal] Export is possible with metadata appended.

Select an item from the [Name] list, and enter
metadata at [Value].

[Import] Import XMP format (*xmp) metadata. This is
reflected in the [Metadata] setting.
[Export] Export the settings made at [Metadata] in XMP
format.
H.265/HEVC Format

Category name in [Print to
File] dialog box

[H.265/HEVC] [H.265/HEVC]

Exporter

% [H.265/HEVC] Exporter

For the setting items, see the descriptions given for [Blu-ray] exporter.
[Blu-ray] Exporter»P75
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AVCHD Format

Category name in [Print to
File] dialog box
[AVCHD] [AVCHD] (When exported to a file)
[AVCHD Writer] (When exported to
removable media)

Exporter

Note * When exporting to the internal hard disk, internal
memory or removable disk of an AVCHD camera for
playback on the AVCHD camera, you may be unable to
perform the export or playback depending on the camera.

* Depending on the type of save destination, a warning message
may be displayed saying that data will become unrecognizable.
Be sure to create a backup before export, as required.

¢ If a stream file size exceeds 2 GB, it will be split up before

export.

s [AVCHD Writer] Exporter

Farmat

5D Memory Card ® Memory Stick /HDD Camera

[Destination] [Drive]
Select this option to output files to an SD

memory card or Memory Stick.

[Folder]
Select this option to output AVCHD stream files

to a selected destination. Click [Browse] to set
the destination.

[Format] Select according to the media being used.

+ Common Settings for [AVCHD Writer] / [AVCHD] Exporter

> [Basic Settings] tab/[Extended Settings] tab

For the setting items, see the descriptions given for [Blu-ray] exporter.

[Blu-ray] Exporter» P75
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XDCAM EX Format

Category name in [Print to
File] dialog box
[XDCAM] [XDCAM EX DV]
[XDCAM EX]

Exporter

Note * Be sure to format the SxS memory card with the XDCAM
EX device in advance.

<+ [XDCAM EX] / [XDCAM EX DV] Exporter

The setting items will differ depending on the exporter.

Memoary Card

DHC Memoary Card

Quality/Speed Mormal

Title 1 (US ASCII) :

Title2 :

Description :

[Destination] Select whether to export to an SxS memory card,

to export to an SDHC memory card or to save to a
desired folder. A file is exported in a folder structure.
If [Sony - SxS Memory Card] or [JVC - SDHC
Memory Card] is selected, select a card from the list.
If [Automatically select the next card when card

is full] is checked, when free space runs out

on the S5xS memory card selected as the export
destination, an 5xS memory card with free space
will be selected automatically and exported to. If
it is unchecked, a dialog box will be displayed to
select the export destination.

If [Folder] has been selected, click [...] and specify
a save destination.
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[Segment Check this item to export a clip of a raw source

Encode] without re-encoding. This increases the output
speed.

[ClosedGOP] Check this item to complete information within

each GOP. Although the amount of data increases,
the video can be re-edited using software that
supports GOP-based editing.

[Audio/Stereo]

Check this item to export the audio as a stereo
track. This is only displayed when the audio
channel is 2ch.

[Mode]

Select an image quality mode (SP or HQ).

[Quality/Speed]

Select quality from the list. The higher the quality,
the more time it takes to be encoded.

Metadata

Add metadata such as title and comments to clips
to be exported.

> [Select Memory Card Drive] Dialog Box
When the clip is to be split, a dialog box appears to select the export

destination.
[Memory Card]: Select the next memory card drive.
[LI/IR]
[OK] Click this item after selecting a drive or after
replacing a memory card.
GF Format
Category name in [Print to
gF"\é] dialog box 24HIG
[GF] [GF clip]
[GEF clip (DV)]
[GF clip (DVCPRO25)]
[GF clip (DVCPRO50)]
[GF clip (SD)]

Note ¢ If a clip consists of files with a size that exceeds 4 GB, it
will be split up before export.
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< [GF clip]/ [GF clip (DV)]/[GF clip (DVCPRO025)] / [GF
clip (DVCPRO50)]1 / [GF clip (SD)] Exporter

The setting items will differ depending on the exporter.

Bin

Clip Title

IFrame Only(10...

Mormal

Audio Channels ach

Audio Quantization Bit Rate 16bit

[Destination] Select whether to export to a GF drive or save to a
desired folder.

If [GF Drive] has been selected, select a Drive from
the list.

If [Folder] has been selected, click [Select] and
specify a save destination.

[Bin]

Set the BIN in which to register the exported clip.
Select from the list, or click [Append], enter a BIN
title and register anew to the list.

[Clip Title] Enter the name of the clip to be exported.

[Segment Check this item to export a clip of a raw source

Encode] without re-encoding. This increases the output
speed.

[Gop Typel Select the GOP type from [I-Frame Only(100

Mbps)] or [Long GOP(50 Mbps)].
[Quality/Speed] | Select a quality.

[Bit Rate] Select a bitrate from the list.

[Audio Channels] | Select the number of audio channels.

[Audio Select an audio quantization bitrate.
Quantization Bit
Rate]
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Infinity Format

Category name in [Print to
File] dialog box 201G
[Infinity] [Infinity DV]
[Infinity JPEG2000]
[Infinity D10]
[Infinity MPEG]

+¢ [Infinity MPEG] / [Infinity DV] / [Infinity JPEG2000] /
[Infinity D10] Exporter

The setting items will differ depending on the exporter.

Destination

Infinity Drive

60Mbps

MNormal

24pit/4ch

[Destination] Select whether to export to an Infinity drive or
save to a desired folder.

If [Infinity Drive] has been selected, select a Drive
from the list.

If [Folder] has been selected, click [Select] and
specify a save destination.

[Clip Name] Enter the name of the clip to be exported.

[Playlists] Select whether the playlist name has the same
name as the clip name. If [Specified the playlist.]
has been selected, enter a playlist name.

[Segment Check this item to export a clip of a raw source
Encode] without re-encoding. This increases the output speed.
[Bit Rate] Select a bitrate from the list.

[Quality/Speed] | Select a quality.

[Audio Format] | Select an audio quantization bitrate and a number
of audio channels from the list.
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P2 Format
Category name in [Print to
File] dialog box Exporter
(P2] [HD P2 Clip]
[AVCUItra P2 Clip]
[P2 Clip]

POINT  ° If datais to be exported using the AVC-Intra or AVC-
Ultra codec and a project template that satisfies all the
following conditions is applied, HDR metadata will be
added to the output data.

- When [Color Space] in [Project Settings] is set to
[BT.2020/BT.2100 HLG] or [BT.2020/BT.2100 PQ)].

- When [Primary Color Correction] is applied, [Source] is
set to [Auto], and [Destination/LLUT] is set to [BT.2020/
BT.2100 HLG] or [BT.2020/BT.2100 PQ)].

Note * Make sure that the P2 device drivers are already

installed.

¢ Audio will be exported in 16-bit format audio, even if the
source file is set to 24-bit format audio.

¢ If there is no more free space in the export destination, or
if the clip consists of files with a size that exceeds 4 GB, it
will be split up before export.

¢ [f exporting at 720p, the export frames must be even
frames. If a confirmation message appears, select a
processing method.

¢ If a DVCPRO HD export format and the settings content
for the source file differ, the export data will be stretched
before export so that the frame rate and the field order
correspond to each other.
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< [HD P2 Clip] / [AVCUItra P2 Clip] / [P2 Clip] Exporter

The setting items will differ depending on the exporter.

User Clip Name transcoder_project

Last Update Person

n BitRate  16hit

¥ Automatically select the next card when card is full. Load Metadata. ..

[Destination]

Select whether to export to a P2 drive or save to a
desired folder.

If [P2Card] has been selected, select a Card from
the list.

If [Folder] has been selected, click [Select] and
specify a save destination.

[User Clip
Namel

Enter the name of the clip to be exported.

[Video settings]

Select a codec from the list.

[Audio settings]

Select an audio quantization bitrate.

Metadata

Click on a tab to input metadata.

[Automatically
select the next
card when card
is full.]

If you check this item, when the clip is split, a
P2 card drive that has free space will be selected
automatically and exported to. If it is unchecked,
when the clip is split, a dialog box will appear to
select the export destination.

[Load Metadatal

Metadata, such as the created by and capture

information, can be imported from another P2
clip. Click [Load Metadata] and select the XML file
to be imported.
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XDCAM Format

Category name in [Print to
File] dialog box Exporter
[XDCAM] [XDCAM DV]
[XDCAM MPEG IMX]
[XDCAM HD]
[XDCAM HD 422]
[XDCAM HD 720P]

Note * Be sure to format the SxS memory card with an XDCAM
device in advance.

¢ Files cannot be exported to an SxS memory card
formatted in the XDCAM EX format.

* Proxy files will not be exported.

¢ If a clip is exported that does not include high-resolution
or proxy data, a dialog box will appear to set the
processing before export. Select a processing method and
click [OK].

e [f [XDCAM MPEG IMX] was selected, 3 lines (black)
will be added above and below the 720x480 video to be
exported as Even (Top Field First).

Also, 720x576 (Odd) video will be shifted by 1 line to be
exported as Even (Top Field First).

» [XDCAM HD] / [XDCAM DV]/[XDCAM MPEG IMX] /
[XDCAM HD 422] / [XDCAM HD 720P] Exporter

The setting items will differ depending on the exporter.

#® Folder
Clip Name
Segment Encode

25Mbps

MNormal

Audio Format 16bit/2ch
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[Destination] Select whether to export to an XDCAM drive,

to an FTP server, or to a desired folder. A file is
exported in a folder structure.

If [XDCAM Drive] was selected, select a Drive
from the list.

If [FTP] was selected, check the server to be
exported to and, as necessary, check the item
described below.

If [Folder] was selected, click [Select] and specify a
save destination.

[Upload to FTP after exporting file.]

Check this item to export a temporary file to the
project folder, and then upload the actual data to
an FTP server. After outputting the temporary
file, if an error occurs during transfer to the FTP
server or if the upload is aborted, the temporary
file will not be deleted.

[Clip Name] Set the file name to be exported.

[Auto (C****)]

If [Auto (C***¥)] is checked, a file name will be set
automatically. To set a preferred file name, remove
the check from [Auto (C****)] and enter a name

in [Clip Name]. (“Clip Naming” must be set as
“Free” on the XDCAM drive.)

[Segment Check this item to export a clip of a raw source

Encode] without re-encoding. This increases the output
speed.

[Bit Rate] Select a bitrate from the list.

[Quality/Speed] | Select a quality.

[ClosedGOP] Check this item not to use the B-picture at the

GOP border as reference across GOPs. Although
the amount of data increases, the video can be
re-edited using software that supports GOP-based
editing, as the information is completed within
each GOP.

[Audio Format] | Select the audio format to export.
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XAVC S Format
Category name in [Print to
File] dialog box Exporter
[XAVC] [XAVC S]
POINT  ° If a project template that satisfies all the following

conditions is applied, HDR metadata will be added to
the output data.

When [Color Space] in [Project Settings] is set to
[BT.2020/BT.2100 HLG] or [BT.2020/BT.2100 PQ].

When [Primary Color Correction] is applied, [Source] is
set to [Auto], and [Destination/LUT] is set to [BT.2020/
BT.2100 HLG] or [BT.2020/BT.2100 PQ)].

Note ¢ Be sure to format the XQD memory card with an XAVC S
device in advance.

% [XAVC S] Exporter

Destination

S0Mbps ls] Linear PCM v

Quality Normal

Title1 (US ASCII) :

Title2 :

Description :

[Destination]

Select whether to export to an XAVC S device or
to a desired folder. A file is exported in a folder
structure.

If [Memory Card] is selected, select a device from
the list.

If [Folder] is selected, click [...] and specify a save
destination.
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[Video Settings] | [Bit Rate]

Select a bitrate from the list.

[Quality]

Select an image quality.

[Use Hardware Encoder]

Check this item to output video using hardware
encoding such as Quick Sync Video.

Unchecking this item will output video using H.264
software encoder that enables high-quality and high-
speed encoding.

In an environment where hardware encoding is

not available, [Use Hardware Encoder| will not be
displayed. The encoder for output will be fixed to
H.264 software encoder.

[Audio Settings] | Select the audio format of the video to be exported.

Metadata Add metadata such as title and comments to clips
to be exported.

XAVC Format

Category name in [Print to
File] dialog box

[XAVC] [XAVC]

Exporter

POINT ° If a project template that satisfies all the following
conditions is applied, HDR metadata will be added to
the output data.

- When [Color Space] in [Project Settings] is set to
[BT.2020/BT.2100 HLG] or [BT.2020/BT.2100 PQ].

- When [Primary Color Correction] is applied, [Source] is
set to [Auto], and [Destination/LUT] is set to [BT.2020/
BT.2100 HLG] or [BT.2020/BT.2100 PQ)].

Note * Be sure to format the SxS memory card with an XDCAM
device in advance.
¢ Files cannot be exported to an S5xS memory card
formatted in the XDCAM EX format.
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Upload to FTP after exporting file.

Output Setting for Each Format

#® Folder

Clip Name

Auto (C***%)

Format
Quality/Speed Fine

Audio Channels Auto

Intra Class 50

[Destination]

Select whether to export to an XDCAM drive,

to an FTP server, or to a desired folder. A file is
exported in a folder structure.

If [XDCAM Drive] was selected, select a drive
from the list.

If [FTP] was selected, check the server to be
exported to and, as necessary, check the item
described below.

If [Folder] was selected, click [Select] and specify a
save destination.

[Upload to FTP after exporting file.]

Check this item to export a temporary file to the
project folder, and then upload the actual data
to an FTP server. After exporting the temporary
file, if an error occurs during transfer to the FTP
server or if the upload is aborted, the temporary
file will not be deleted.

[Clip Name] Set the file name to be exported.
[Auto (C****)]
If it is checked, a file name will be set
automatically. To set a preferred file name, remove
the check from [Auto (C****)] and enter a name
in [Clip Name]. (“Clip Naming” must be set as
“Free” on the XDCAM drive.)

[Format] Select the format to export.

[Quality/Speed] | Select quality and speed.

[Audio Select the number of audio channels.

Channels]
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K2 (GXF) Format

Category name in [Print to
File] dialog box

Exporter

[K2]

—

AVClntra GXF]
AVCUltra GXF]
D10 GXF]

DNxHD GXF]

DV GXF]
DVCPRO25 GXF]
DVCPRO50 GXF]
DVCPROHD GXF]
JPEG2000 GXF]
MPEG2 GXF]

—

————,— — — —

Note ¢ Audio will be exported in 16-bit format audio, even if the
source file is set to 24-bit format audio.

< [MPEG2 GXF] / [AVCIntra GXF] / [AVCUItra GXF] / [D10
GXF] /[DNxHD GXF] /[DV GXF] / [DVCPR025 GXF]
/ [DVCPRO50 GXF] /[DVCPROHD GXF] / [JPEG2000

GXF] Exporter

The setting items will differ depending on the exporter.

Select...

Directory  User N...

GOP structure

MPE@H 14

Current setting v  Quantization Bit Rate Current setting v
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[Clip Name] Enter the name of the clip (file) to be exported.

[Destination] Select whether to export to a desired folder or to
an FTP server.

If [Folder] was selected, click [Select] and specify a
save destination.

If [FTP] was selected, check the server to be
exported to and, as necessary, check the items
described below.

[Overwrite file when it exists]

Check this item to overwrite a file if the file with
the same file name is present at the FTP server of
the export destination.

[Upload to FTP after exporting file]

Check this item to export a temporary file to the
project folder, and then upload the actual data to
an FTP server. After outputting the temporary
file, if an error occurs during transfer to the FTP
server or if the upload is aborted, the temporary
file will remain undeleted.

[Do not add file extension when exporting to FTP]
Check this item to export a file without adding the
file extension to the name entered in [Clip Name].
(If [Clip Name] contains a file extension, export
will take place with a clip file name with its file
extension removed.)

When this item is unchecked, export will take
place with the “*.gxf” file extension added if the
name entered in [Clip Name] does not include the
file extension.

[Keep the Becomes enabled if [Upload to FTP after exporting
created file file] is unchecked.

when aborting] If it is checked and export is aborted, the file
created up to the time point of the abort will
remain at the export destination.
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[Encode
Settings]

[Segment Encode]

Check this item to export a clip of a raw source
without re-encoding.

This increases the output speed.

[Bit Rate]

Select a bitrate type.

[CBR] sets a fixed transfer rate, allocating a fixed
number of bits during the encoding process. Enter
an average bitrate in [Average].

[VBR] sets a variable transfer rate, altering

the number of assigned bits according to the
complexity of the movement or image quality.
Enter the average bitrate in [Average], and
maximum bitrate in [Max].

[Quality/Speed]
Select quality from the list.

[Field Order]
The field order can be selected if it is in SD format.

[GOP structure]

Select I, P and B frame patterns of the GOP from
the list. Normally, select [IBBP].

[I-Frame Only] is comprised of only I-pictures.
Editing is made easier, but the amount of data
increases in size.

[Picture count]
Enter the number of frames included in 1 GOP.

[Closed GOP]

If it is checked, the GOP will be closed. Although
the amount of data increases, the video can be
re-edited using software that supports GOP-based
editing, as the information is completed within
each GOP. Normally, leave this item unchecked.

[Chroma Format]
Select a YUV pixel format from the list.
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[Profile/Level]

Select a profile & level. If [Chroma Format] is
[4:2:0] and [4:2:2], the profile will be set to Main
Profile and 422Profile, respectively. The level for
SD image quality will be Main Level, and the level
for HD image quality will be High Level. The
profile & level changes according to the format
selected in [Chroma Format].

[Bit Rate]

Select a bitrate from the list.

[Format]

Select the format to export.

[Audio Settings]

[Channels]

Select the number of audio channels you want

to export from the list. [Current setting] is the
number of channels configured in the source file.
If [Enable Conversion] is checked for the exporter
and the number of channels for the audio format
is changed from the source file, the number of
channels will be the number set here.

[Quantization Bit Rate]

Select the number of bits to be used during
sampling. [Current setting] is the number of bits
configured in the source file.

K2 (CMF) Format

Category name in [Print to
File] dialog box

Exporter

(K2]

[K2 AVClIntra Clip]
[K2 AVCUltra Clip]
[K2 AVCHD Clip]
[K2 D10 Clip]

[K2 DNxHD Clip]
[K2 DV Clip]

[K2 DVCPRO HD Clip]
[K2 MPEG2 Clip]

[K2 XAVC Clip]
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< Common Settings for [K2 AVCintra Clip] / [K2 AVCUltra
Clip] / [K2 AVCHD Clip] / [K2 D10 Clip] / [K2 DNxHD
Clip]l / [K2 DV Clip] / [K2 DVCPRO HD Clip] / [K2
MPEG2 Clip] / [K2 XAVC Clip] Exporter

Overwrite file when it exists

program sequence

XDCAM EX HQ

Segment Encode

Audio Settings

Channels Current Setting v Quantization Bit Rate  Current Setting

[Clip Name]

Enter a clip name for the file to be exported.

[Destination]

[Server]
Select a file export destination from the list.

[Bin]
Displays the list of bins in the save destination
you selected in [Server].

[Overwrite file when it exists]

Check this item to overwrite a file if any file
with the same clip name is already registered in
the bin in the export destination.

[Sequence
Settings]

[Export as a program sequence]
Check this item to export sequences as
programs.
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[Audio Settings]

[Channels]
Select the number of audio channels you want
to export from the list.

[Quantization Bit Rate]

Select an audio quantization bitrate from the
list.

% [Video Settings] in the [K2 MPEG2 Clip]/ [K2 DV Clipl/
[K2 AVCintra Clip]/ [K2 AVCUItra Clip] / [K2 XAVC Clip]

Exporter

The setting items will differ depending on the exporter.

XDCAM EX HQ

[Format]

Select an export format from the list.

[Segment Encode]

Check this item to export a clip of a raw source
without re-encoding.
This increases the output speed.

[Quality/Speed]

Select quality from the list.

[Bit Rate]

Select a bitrate type.

[CBR] sets a fixed transfer rate, allocating a fixed
number of bits during the encoding process.
Select a bitrate from the [Average] list. You can
also enter a value directly.

[VBR] sets a variable transfer rate, altering

the number of assigned bits according to the
complexity of the movement or image quality.
Compared with [CBR], the media volume can
be used more efficiently, and this enables more
consistent image quality overall. Select a bitrate
from the [Average] and [Maximum] lists. You
can also enter a value directly.
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[GOP structure] For MPEG, a certain number of frames is
considered as a group, and operations such as
compression/enlargement and cut editing are
performed on a GOP basis. A GOP comprises “I
frame”, “P frame” and “B frame”. The I frame
allows images to be reproduced independently,
the P frame is for recording and reproducing
only the differences with the preceding image,
and the B frame reproduces images from the
differences in the preceding and following
images. Select I, P and B frame patterns of the
GOP from the list. Normally, select [IBBP].
[I-Frame Only] is comprised of only I-pictures.
Editing is made easier, but the amount of data
increases in size.

[Picture count] Set the number of frames included in a group.

[Closed GOP] Check this item to complete information
within each GOP. Although the amount of data
increases, the video can be re-edited using
software that supports GOP-based editing.
Normally, leave this item unchecked.

[Chroma Format] Select a YUV pixel format from the list.

[Profile/Level] Select a profile & level. If [Chroma Format] is
[4:2:0] and [4:2:2], the profile will be set to Main
Profile and 422Profile, respectively. The level for
SD image quality will be Main Level, and the
level for HD image quality will be High Level.
The profile & level changes according to the
format selected in [Chroma Format].

% [Video Settings] in the [K2 D10 Clip]/ [K2 DNxHD Clip]
Exporter

50Mbps

[Bit Ratel] Select a bitrate from the list.
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% [Video Settings] in the [K2 AVCHD Clip] Exporter

Quality : MNormal

ICR Interval :

B Frame :

Minimum B

Intra :

Inter :

[Profile]

Set the profile. The selectable profiles will differ
depending on the frame size to be exported.

[Bit Rate Typel

[CBR] assigns a constant number of bits.
Although noise, etc. may be present, the
encoding process is made quicker.

[VBR] changes the assigned bitrate according
to the complexity of the movement or image
quality. Compared with [CBR], the media
volume can be used more efficiently, and this
enables more consistent image quality overall.

[Average]

Set this item if [CBR] or [VBR] has been selected
as the bitrate type. You can either select from
the list or enter values directly.

[Max]

Set this item if [VBR] has been selected as the
bitrate type. You can either select from the list
or enter values directly.

[Quality]

Select the image quality from the list.

[IDR Interval]

Enter the IDR frame interval, and set the GOP
size.

[B Framel Set the number of B-frames included in one
GOP.
[Multi Slice] Check this item to divide 1 frame into 4 parts.

If the decoder supports multi-slicing, the
decoding may be made quicker.

[Entropy Coding
Mode]

Select the H.264 encoding mode.

[Number of
Reference Frames]

Set up to how many frames should be
considered when motion estimation is
performed.
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[Motion Estimation | Select the unit of division for the motion
Precision] estimation block from the list.

[Minimum Block Set the block size during motion estimation for
Size of Prediction] | intra-frames/inter-frames.

MXF Format

Category name in [Print to
File] dialog box

Exporter

[MXF]

[MPEG2 Legacy MXF]
[AVCIntra MXF]
[AVCUltra MXF]

[D10 MXF]
[DNxHD MXF]

[DV MXF]
[DVCPRO25 MXF]
[DVCPRO50 MXF]
[DVCPROHD MXF]
[HQ MXF]

[HQX MXF]
[JPEG2000 MXF]
[MPEG2 MXF]
[ProRes MXF]
[XAVC MXF]

POINT  ° If [HQ MXF], [HOX MXF], [AVCIntra MXF], [AVCUltra
MXEF], or [XAVC MXF] is set for the exporter and a
project template that satisfies all the following conditions
is applied, HDR metadata will be added to the output

data.

- When [Color Space] in [Project Settings] is set to
[BT.2020/BT.2100 HLG] or [BT.2020/BT.2100 PQ].

- When [Primary Color Correction] is applied, [Source] is
set to [Auto], and [Destination/LUT] is set to [BT.2020/
BT.2100 HLG] or [BT.2020/BT.2100 PQ)].

XRE Transcoder — User Guide



Output Setting for Each Format

<+ [MPEG2 Legacy MXF] / [MPEG2 MXF] / [AVCIntra
MXF] / [AVCUItra MXF] /[D10 MXF] / [DNxHD
MXF] / [DV MXF] / [DVCPRO25 MXF] / [DVCPRO50
MXF] / [DVCPROHD MXF] / [HQ MXF] / [HQX MXF]
/ [JPEG2000 MXF] /[ProRes MXF] / [XAVC MXF]
Exporter

The setting items will differ depending on the exporter.

420

MP@H 14 v

[Clip Name] Enter the name of the clip (file) to be exported.
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[Destination] Select whether to export to a desired folder or to
an FTP server.

If [Folder] was selected, click [Select] and specify a
save destination.

If [FTP] was selected, check the server to be exported
to and, as necessary, check the items described below.

[Overwrite file when it exists]

Check this item to overwrite a file if the file with
the same file name is present at the server of the
export destination. Uncheck this item to display a
confirmation message.

[Upload to FTP after exporting file]

Check this item to export a temporary file to the project
folder, and then upload the actual data to an FTP server.
After outputting the temporary file, if an error occurs
during transfer to the FTP server or if the upload is
aborted, the temporary file will not be deleted.

[Do not add file extension when exporting to FTP]
Check this item to export a file without adding the file
extension to the name entered in [Clip Name]. (If [Clip
Name] contains a file extension, export will take place
with a clip file name with its file extension removed.)
Uncheck this item to export a file with the “*mxf”
added if the name entered in [Clip Name] does
not include the file extension.

[Keep the Becomes enabled if [Upload to FTP after exporting
created file file] is unchecked.

when aborting] | When this item is checked, the file being uploaded
will be completed if an upload is aborted.

[Encode [Segment Encode]

Settings] Check this item to export a clip of a raw source
without re-encoding.

This increases the output speed.

[Bit Rate]

Select a bitrate type.

[CBR] sets a fixed transfer rate, allocating a fixed
number of bits during the encoding process. Enter
an average bitrate in [Average].

[VBR] sets a variable transfer rate, altering the
number of assigned bits according to the complexity
of the movement or image quality. Enter the average
bitrate in [Average], and maximum bitrate in [Max].
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[Quality/Speed]
Select quality from the list.

[Field Order]
The field order can be selected if it is in SD format.

[GOP structure]

Select I, P and B frame patterns of the GOP from
the list. Normally, select [IBBP].

[I-Frame Only] is comprised of only I-pictures.
Editing is made easier, but the amount of data
increases in size.

[Picture count]
Enter the number of frames included in 1 GOP.

[Closed GOP]

If it is checked, the GOP will be closed. Although
the amount of data increases, the video can be
re-edited using software that supports GOP-based
editing, as the information is completed within
each GOP. Normally, leave this item unchecked.

[Chroma Format]
Select a YUV pixel format from the list.

[Profile/Level]

Select a profile & level. If [Chroma Format] is [4:2:0]
and [4:2:2], the profile will be set to Main Profile

and 422Profile, respectively. The level for SD image
quality will be Main Level, and the level for HD
image quality will be High Level. The profile & level
changes according to the format selected in [Chroma

Format].
[Bit Rate] Select a bitrate from the list.
[Format] Select the format to export.
[HQX CODEC For the setting items, see the descriptions given
settings] for [Grass Valley HQ AVI] / [Grass Valley HQX

AVI] exporter.
[Grass Valley HQ AVI] / [Grass Valley HQX AVI]
Exporter» P67
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[Audio settings] | [Channels]

Select the number of audio channels you want

to export from the list. [Current setting] is the
number of channels configured in the source file.
If [Enable Conversion] is checked for the exporter
and the number of channels for the audio format
is changed from the source file, the number of
channels will be the number set here.

[Quantization Bit Rate]

Select the number of bits to be used during
sampling from the list. [Current setting] is the
number of bits configured in the source file.

[Channels Per Track]
Specify the number of channels to be included in
1 audio track for MXF.

[Typel
Select the audio format to export.

[System Typel Select a system item format.

[KAG Size] Select a KAG (KLV Alignment Grid) size.
[Operational Select Operational Pattern from the list.
Pattern]
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Checking job status

The progress status and history of jobs can be checked in the job list of
XRE Transcoder.

If it is running on the XRE Service, the “management mode” is active.
The job list shows not only the jobs requested by XRE Transcoder, but
jobs requested by EDIUS.

1 Double-click the XRE Transcoder icon on the desktop.

2

XRETranscoder

If XRE Transcoder is already started and the XRE Transcoder icon
is in the task tray, right-click on the icon and then click [Open XRE
Transcoder].

Alternative

¢ From the start menu, click [Grass Valley] > [XRETranscoder].

 [XRE Transcoder] Dialog Box

(13)

(14)

ER——> < (e

(7

(1) Menu bar The menu bar also allows you to perform the
operations from (2) to (12) in the table.
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(2) [Add job] Specify a desired file and request conversion
process (transcode job) to the XRE Service.
Specifying and Converting a File» P33

(3) [Restart]” Click this button to restart a job after selecting a
paused or stopped job from the [Job List (above)].

(4) [Pausel’ Pauses the job you selected from the [Job List
(above)].

(5) [Stopl” Stops the job you selected from the [Job List
(above)].

ance ancels the job you selected from the [Job List

(6) [C I C Is the job y. lected f he [Job Li
(above)]. The canceled job will move to the
[Job List (below)].

(7) [Retryl” Performs the job you selected from the [Job

List (below)] again.

(8) [Properties] Shows the properties of the job you selected
from the [Job List (above)] or [Job List (below)].
Checking job properties» P112

(9) [Job's priority  Raise the priority of the job selected in [Job
upl* List (above)].
Raising/Lowering Job Priority»P114

(10) [Job's priority ~ Lower the priority of the job selected in [Job

down]* List (above)].
Raising/Lowering Job Priority»P114
(11) [Settings] Configure settings in [Server setting], [Error

notification], and [Watch Folder].
Configuring XRE Transcoder» P16

(12) [Plug-in Configure the plug-in settings.
settings] Plug-in settings» P22
(13) [Server] The currently connected XRE Service is

displayed. Clicking the list shows the list of
the XRE Services stored as destinations, which
allows you to switch the XRE Service to check
job status.

(14) Job List (above) Shows the active jobs and jobs waiting to be
performed.
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(15) [Error]/[Info] Choose the job history types to be shown. To
show all of the job history, click both of them.

[Error]
Click this to show only jobs in which errors
occurred.

[Info]
Click this to show jobs in which no error
occurred (successful and canceled ones).

(16) [Search] Enter a keyword to narrow down the search
result of the [Job List (below)].

(17) Job List (below) Shows the history of the performed jobs.
A successful job is shown with B . job in
which an error occurred is shown with ﬂ,
and a canceled job is shown with [l
The number of days to keep the history can be
configured on the XRE Service.

(18) Close Closes the [XRE Transcoder] dialog box.

*On PCs other than for the XRE Service, only the user who has
requested the job can perform operations regarding their own job.

POINT ° Clicking on an item name in the [Job List (above)]/[Job
List (below)] can sort the rendering jobs in ascending or
descending order.

¢ Displayed items can be customized. Right-click on an
item name, and then check the item(s) to display.
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About error notifications

If an error occurs during job process, an error message appears near
the task tray.

<]

¥ Error (1)

If you click the error message, it disappears.

POINT ° You can check the type of errors you will be notified of

and change it.
Configuring XRE Transcoder» P16

* You will not be notified of error details. You can check
them in the [Job List (below)] of the [XRE Transcoder]
dialog box. A job in which an error occurred is shown
with L
[XRE Transcoder] Dialog Box» P109

Checking job properties

1 Select a job from the [Job List (above)] or [Job List (below)],
and then click [Properties].

@l XRE Transcoder

Eile Action Setting

High
-9B,,. Enginel Rende... Normal

9B... Enginel  Rende... MNormal 10

Alternative

* Select a job from the [Job List (above)] or [Job List (below)], and then
click [Action] > [Properties] from the menu bar.

* Select a job from the [Job List (above)] or [Job List (below)], right-click
on it, and then click [Properties].

* Double-click a job in the [Job List (above)] or [Job List (below)].
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% [Job Properties]

> [General] tab

POINT ° You can configure the [Job Name], [Priority], and

[Comment] settings for a job in the [Job List (above)].

¢ In XRE Transcoder (management mode), you can change
the [Job Name], [Priority], and [Comment] settings for
all jobs. On PCs other than for the XRE Service, only the
user who has requested the job can change [Job Name],
[Priority], and [Comment] of their own job.

* Properties of a job in the [Job List (below)] cannot be
changed. When viewing properties of a job in the [Job
List (below)], [History] appears in the dialog box caption.

XRE Transcoder — User Guide 113



Section5 — XRE Transcoder Operations

114

> [Details] tab

Job Properties - History

You can view the properties of the next upper or lower job from the
currently displayed one by clicking [ or &

Raising/Lowering Job Priority

Three priority levels, [High], [Normal], and [Low] can be set for job
execution order. Jobs set to [High] are prioritized.

POINT ° On PCs other than those for the XRE Service, priority
can be set only for jobs ordered by the user.

1 Select a job from the [Job List (above)], and then click either
[Job's priority up] or [Job's priority down)].

®ll XRE Transcoder

Eile Action Setting

Status

3... Enginel Stop MNormal

... DESKTOP-9B... Enginel  Rende... MNormal 10

Alternative

* Select a job from the [Job List (above)], and then click [Action] > [Job's
priority up] or [Job's priority down] from the menu bar.

* Select a job from the [Job List (above)], right-click on it, and then click
[Job's priority up] or [Job's priority down].
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. Section

Appendix

Supported Format

Input format

< Video
Format File extension
3GP *3gp, *.3g2
ASF *.asf
AVCHD *m2ts, *.mts
AVI File *.avi
CompuServe GIF Files *.gif
DIF stream *dif, *.dv
DPX (SMPTE 268M-2003) Files *.dpx
F4V * f4v
ICO Decoder *1ico, *.icon
JPEG Decoder *jpe, *.exif
JPEG File Interchange Format Files * jfif
JPEG Files *jpg, *jpeg
MOV *.mov
MP4 *mp4, *.m4v
MPEG HDD MOVIE *.mod, *.tod
MPEG Program Stream *mpg, “mpeg, *m2p, *mp2, *vob, *vro
MPEG Transport Stream *m2t
MPEG Video Stream *mpv, *m2v
MXF *mxf
Maya IFF *iff
Multi-PictureFormat *mpo
Photoshop Files *psd
Portable Network Graphics Files *png
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Format File extension
Quick Titler *etl

RED File *R3D

SGI Files *.sgi, *rgb

Sony HVR-DR60/HVR-MRC1 Meta File *idx

TIFF Files *tif, *.tiff

Targa Files *tga, *.targa, *vda, *.icb, *vst
Transport Stream *ts

WMPhoto Decoder *wdp, *jxr
Windows Bitmap Files *bmp, *.dib, *.rle
Windows Media *wmv, *.asf
Windows Meta Files *wmf, *.emf

XF Clip File *cif

Spanned clips such as for P2 or XDCAM *xml

* When you use the Watch folder function, spanned clips such as for P2 cannot be specified as
source files.

+» Audio

Format File extension
AAC *.aac, *m4a
AIFF* *.aiff, *.aif
Dolby Digital (AC-3) *.ac3

Dolby Digital Professional (AC-3) *.ac3

Dolby Digital Plus (E-AC-3) *.ec3

MPEG Audio Layer-3* *mp3
MPEG Audio Stream *mpa, *m2a
Ogg Vorbis file *.088

Wave *wav
Windows Media Audio *wma

*1 AIFF/AIFC files are PCM only.
*2 Some VBR are not supported.
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+»+ Formats Added at Installation of QuickTime

Format File extension
3GPP Files *.3gp, *.3g2, *.amc
AAC Files *aac, *.m4a
Flash Pix Files *fpx

Flash Video *fAv

MPEG4 File *mp4, *mdv
Mac Pict Files *.pic, *.pct, *.pict
QuickTime Image Files *.qtif, *.qti, *qif
QuickTime Movie * mov

Output format

“ Video

Note * Some formats may not support codec.

* Depending on the device specifications and compatibility, playback and output on
the device may not be supported.

Category
Format/ File name in
container Codec extension | [Print to File] Exporter Page
dialog box
AVCHD — *m2ts  [AVCHD] | [AVCHD] > P84
[AVCHD Writer]
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Category
cl:lzrt?iite/r Codec ext::.lr::ion [Pr';:tn:z :::Ie] Exporter Page
dialog box
AVI Grass Valley HQ *avi [AVI] [Grass Valley HQ AVI] | »P66
Grass Valley HQX [Grass Valley HQX AVI]
Grass Valley Lossless [Grass Valley
Lossless AVI]
DV [DV AVI]
DVCPRO50 [DVCPROS50 AVI]
DVCPRO HD [DVCPRO HD AVI]
Uncompressed (RGB) [Uncompressed
(RGB)AVI]
Uncompressed [Uncompressed
(RGBA) (RGBA)AVI]
Uncompressed [Uncompressed
(UYVY) (UYVY)AVI]
Uncompressed [Uncompressed
(YUY2) (YUY2)AVI]
Uncompressed (v210) [Uncompressed
(v210)AVI]
Blu-ray H.264/AVC *m2ts [H.264/AVC] | [Blu-ray] » P75
Flash Video |H.264/AVC *f4v [H.264/AVC] | [F4V] » P82
GF MPEG-2 I-frame only |*xml [GF] [GEF clip] » P86
MPEG-2 Long GOP |+ *mxf
DV [GEF clip (DV)]
DVCPRO25 [GF clip
(DVCPRO25)]
DVCPRO50 [GEF clip
(DVCPRO50)]
SD [GE clip (SD)]
H.264/AVC H.264/AVC *mp4 [H.264/AVC] | [H.264/AVC] »P78
HDV MPEG-2 Transport *m2t [HDV] [HDV] » P73
Stream
H.265/HEVC*! | H.265/HEVC *mp4 [H.265/ [H.265/HEVC] » P83
HEVC]
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Category
clt:::lrt':izte/r Codec ethInI:ion [Pr?:tn:z :::Ie] Exporter Page
dialog box
Infinity DV *xml [Infinity] [Infinity DV] » P88
JPEG2000 +*.mxf [Infinity JPEG2000]
D10 [Infinity D10]
MPEG [Infinity MPEG]
iPod H.264/AVC *mp4 [H.264/AVC] [iPod] » P78
K2 (CMF) AVC-Intra50 *xml [K2] [K2 AVClIntra Clip] » P99
AVC-Intral00
AVC-LongG [K2 AVCUltra Clip]
AVCHD [K2 AVCHD Clip]
D10 [K2 D10 Clip]
DNxHD [K2 DNxHD Clip]
DV [K2 DV Clip]
DVCPRO HD [K2 DVCPRO HD
Clip]
MPEG-2 [K2 MPEG2 Clip]
XAVC [K2 XAVC Clip]
K2 (GXF) AVC-Intra50 *gxft [K2] [AVCIntra GXF] » P96
AVC-Intral00
AVC-LongG [AVCUItra GXF]
D10 [D10 GXF]
DNxHD [DNxHD GXF]
DV [DV GXF]
DVCPRO25 [DVCPRO25 GXF]
DVCPRO50 [DVCPRO50 GXF]
DVCPRO HD [DVCPROHD GXF]
JPEG2000 [JPEG2000 GXF]
MPEG-2 [MPEG2 GXF]
MPEG-2 Video | MPEG-2 *m2v [MPEG] [MPEG2 Elementary | »P78
Elementary Stream]
Stream
MPEG-2 MPEG-2 *mpg, [MPEG] [MPEG2 Program
Program *m2p Stream]
Stream
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Category
cl:lt:lrt'a:]i?lte/r Codec ext::.lr::ion [Pr';:tn:z :::Ie] Exporter Page
dialog box
MP4 H.264/AVC *mp4 [H.264/AVC] | [H.264/AVC] » P78
MXF AVC-Intra50 *mxf [MXF] [AVCIntra MXF] »P104
AV(C-Intral00
AVC-Intra200
AVC-LongG [AVCUlItra MXF]
D10 [D10 MXF]
DNxHD [DNxHD MXF]
DV [DV MXF]
DVCPRO25 [DVCPRO25 MXF]
DVCPRO50 [DVCPRO50 MXF]
DVCPRO HD [DVCPROHD MXF]
Grass Valley HQ [HQ MXF]
Grass Valley HQX [HOX MXF]
JPEG2000 [JPEG2000 MXF]
MPEG-2 [MPEG2 MXF]
[MPEG2 Legacy
MXF]
Apple ProRes [ProRes MXF]
XAVC [XAVC MXF]
P2 AVC-Intra50 *xml [P2] [HD P2 Clip] » P89
AVC-Intral00 + “mxf
AVC-Intra200
AVC-LongG [AVCUltra P2 Clip]
AVC-Intra 4K 422
DV [P2 Clip]
DVCPRO25
DVCPRO50
DVCPRO HD [HD P2 Clip]
PlayStation | H.264/AVC *mp4 [H.264/AVC] |[PlayStation »P78
Portable Portable]
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Category
clt:::lrt?izte/r Codec ethInI:ion [Pr?:tn:z :::Ie] Exporter Page
dialog box
QuickTime Apple ProRes *mov [QuickTime] |[Apple ProRes MOV]| »P73
QuickTime [QuickTime]*?
Grass Valley HQ [Grass Valley HQ
MOV]
Grass Valley HQX [Grass Valley HQX
MOV]
WindowsMedia | — *wmv [Windows | [WindowsMediaVideo] | » P65
Media]
XAVC XAVC Intra *xml [XAVC] [XAVC] » P94
XAVC Long GOP + *mxf
XAVC S§*3 *xml [XAVC S] » P93
+*mp4
XDCAM DVCAM *xml [XDCAM] |[XDCAM DV] » P91
MPEG IMX +*.mxf [XDCAM MPEG
IMX]
MPEG HD [XDCAM HD]
MPEG HD422 [XDCAM HD 422]
MPEG HD 720P [XDCAM HD 720P]
XDCAM EX |DVCAM *xml [XDCAM] |[XDCAM EXDV] » P85
MPEG HD +*.mp4 [XDCAM EX]
DV DV dv [DV] [DV stream|] —

*1 Quick Sync Video (Intel Core i series CPU (6th generation or later)) that supports H.265/HEVC
encoding is required.
*2 If QuickTime has been installed, the following output formats are available.
[3G], [AIFF], [Apple TV], [AU], [AVI], [DV stream], [FLC], [iPhone], [iPhone (Cellular)], [iPod],
[MPEG-4], [QuickTime Movie], [Wave], [Image Sequence]
*3 To load medium where a file has been exported to the camera, perform [Restore Media] on the
camera. Thumbnails cannot be displayed on the camera.
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 Audio
_ File _Categ_orv nal_ne
Format/container extension in [dl:;lll;tgtg:;le] Exporter Page

Dolby Digital (AC-3) *ac3 [Audio] [Dolby Digital (AC-3)] » P68
AIFF *.aif, *aiff | [Audio] [PCM AIFF]
Wave *wav [Audio] [PCM WAVE]
Sony/Sonicfoundry Wave64 | *wo64 [Audio] [Sony/Sonicfoundry

Wave64]
Windows Media Audio *wma [Windows [WindowsMediaAudio]

Media]

Dolby Digital Professional *.ac3 [Audio] [Dolby Digital » P68
(AC-3) Professional (AC-3)]
Dolby Digital Plus (E-AC-3) | *.ec3 [Audio] [Dolby Digital Plus (E-

AC-3)]
MPEG-1 Audio Elementary | *mpa [MPEG] [MPEG2 Elementary »P78
Stream Stream]

Restrictions

* Still images (including still images with increment numbers) cannot be specified as output
formats.

* When you use the Watch folder function, spanned clips such as for P2 cannot be specified as
source files.

* When you use the Watch folder function, an external device cannot be specified as the output
destination.
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